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LYNQ

Knowledgebase

To assist further with
your learning, register
on our portal to watch
videos and read our
knowledgebase
articles and more
support.lyngmes.com

Training Plans

This guide covers the
basic features typically
used by our users. If
the user guide doesn’t
give you everything you
need our Solution
Consultants can
provide tailored
training plans to help
you with your learning.
Drop us an email and
tell us about any
specific requirements
you may have.
service@lyngmes.com

Advanced Users

If you are looking for
an advanced training
guide for your users,
contact our service
team and they will
gladly send you a copy.
service@lyngmes.com
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How to use this guide

LYNQ is reinventing manufacturing execution system (MES) software for small
to midsize manufacturers looking for a configurable, plug-and-play offering to
digitalise and drive their factory performance. Formed around international
standard |EC62264, LYNQ’s all-in-one solution can plan, track, automate,
analyse and optimise factories to increase efficiency, productivity and
profitability.

This guide is designed to cater for new users who required an introduction to
the basic features of LYNQ. You should refer to the following user guides for
advanced application use.

LYNQ Advanced Guides:

e Advanced User Guide

e Factory Automation Feature Guide
¢ Webhooks Feature Guide

e Integration White Paper

Visual APS Advanced User Guide:

e Advanced Resource Settings

e Resource Mapping

e Alternative Resources

e Secondary Constraints for tools

e Product and Global Constraints

e Changeover Minimization

e Bottleneck Scheduling

e Advanced Scheduling Techniques

Anyone learning LYNQ will need to be proficient in the Inventory and
Manufacturing areas of the Enterprise Resource Planning application.

It is recommended that you also view the corresponding online page as
indicated in the tips column panel (left column). Online pages are continually
updated and provide additional links to other relevant pages. The PDF version
of the user guide is only updated annually after each major software release.

When learning using this user guide, you should refer to the glossary. The
glossary explains the mapping between the terms used in the user guide and
the terms used for your Enterprise Resource Planning application. This allows
the user guide to be written in a common language, that supports all LYNQ
customers and partners. The glossary can be found from the LYNQ help menu.
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

LYNQ mes

A hybrid product
combining web based
and desktop
applications to provide
the best possible
customer and user
experience.

LYNQ 2019 USER GUIDE

Components of LYNQ

LYNQ - Manufacturing Operations Management

Frontline managers need complete visibility and control of the shop floor to
prevent problems. Collecting data by conventional methods can be
complicated, time-consuming and expensive.

With LYNQ’s configurable shop floor data collection (SFDC) terminals you are
able to gather time, attendance and production data from your employees and
equipment easily from any device with a browser. Clocking terminals and
interactive job lists simplify the execution of production plans and data capture
of start and stop times, downtime, labour hours, materials issued, quantities
reported, scrap and more

With LYNQ’s out of the box factory performance and loss insight you can
baseline and drive your business to world class standards for overall labour
effectiveness (OLE), overall equipment effectiveness (OEE) and total effective
equipment performance (TEEP).

Visual APS - Advanced Planning & Scheduling

With LYNQ’s comprehensive advanced, finite capacity based, planning and
scheduling (APS), you can quickly and accurately schedule while minimising
downtime. Deliver to your customers faster and in the most cost-effective way,
by creating production plans that factor in constraints around machines,
tooling, personnel and inventory to make smarter use of your materials and
resources.

LYNQ api - Application Program Interface

With LYNQ api you can connect to your Enterprise Resource Planning and
third-party applications.

=) + PROVIDING CONNECTIVITY
TO ERP, WMS, SPC, QMS
AND_OTHER SOFTWARE
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

LYNQ mom license
The license for LYNQ
mom is stored in a sub
directory of the LYNQ
mom website folder.
Once applied all users
will be able to see the
new license details.

LYNQ aps license

The license for LYNQ
aps is stored in a sub
directory of the LYNQ
aps application folder.
The license must be
applied on each
computer or server
where LYNQ aps is
installed.

LYNQ api license

The license for LYNQ
api is stored in a sub
directory of the LYNQ
api website folder.
Once applied all users
will be able to see the
new license details.
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Importing your LYNQ license

A valid license file must be applied to each component of LYNQ. The license is
applied during installation. A new license must be applied annually and under
the following conditions:

1. The legal name of the license has changed
2. The no. of licensed seats has changed

How to import a new LYNQ mom or LYNQ aps license

From LYNQ mom or LYNQ aps click on Help.
Click on Change Product License.
Click Upload license manually to upload a physical license file or

oo

Select Get License Online if you know the license name

LYNQ
Customer service and support

Help with LYNQ
Get help with this screen Product Activated

Customer:

License ID: 1912

Getting Started
A quick start guide to implementation

Expiration Date: 01 January 2020

Change Product License

Check For Customization
Release Notes
New functionality and bug fixes
About
Start-up Configuration Relsass: 2019 R1
Set initial configuration Build: 4.0.1.0

Check For Updates

Terms and Conditions

© powered by LYNQ

How to import a new LYNQ api license

1. From LYNQ api click Settings > Licensing
2. Click Upload license manually to upload a physical license file or
3. Select Get License Online if you know the license name
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Product Version
The version of LYNQ
installed

Company name
The company you are
working in.

User name

The windows user
name you are logged
into LYNQ with.

Message Center

See messages and
management alerts
from the factory floor.

Issue Log

Review, assign and
resolve your
production issues.

Document Library
Add files, forms and
links to Job orders,
Employees and
Equipment.

Personal settings
Switch to a different
user or set language or
localisation

Help

Access online help
with videos and other
articles.

Bookmark

For frequently used
dashboards, views, or
reports.
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Navigating LYNQ

You access LYNQ via a web browser. You will need to contact your systems
administrator to obtain the correct URL for your instance of LYNQ.
Once logged into LYNQ you will find links to the other components such as
Visual APS and LYNQ api. You must however have Visual APS
installed on your computer or on a terminal server to access this
component. LYNQ will try to find the Visual APS application on the computer
or server where your browser is running from. Your rights to the features in
LYNQ will be controlled by your systems administrator.
When rights are disabled, you will still see the menu option but will not be
able to open the feature that has been restricted.

PLANNING WORKFORCE FACTORY

What is at the top of the home page?

PRINT | EMAIL | BOOKMARK

Your systems administrator will control your rights to the features in LYNQ.
When rights are disabled, you will still see the menu option but will not be able
to open the feature that has been restricted.

What is at the bottom of the home page?

Build: 4.0.0.0 Company Name Username

All other features of LYNQ can be accessed directly from the home page.
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LYNQ

Click  to read
this page online.
The online version
provides additional
links to other
related information.

To determine the
global defaults for the
site name, language
and localisation.
User’s wanting to
display the site in
different languages or
localisations can do so

from personal settings.

To send emails from
LYNQ via the message
center, you must
specify email account
credentials. This
account will appear as
the sender on all email
activity

Do not change these
settings unless you
have been instructed
to do so. Changing
these settings will
update the web.config
file.

LYNQ 2019 USER GUIDE

Settings

Settings for LYNQ are accessed from the home page by clicking on the settings
menu in the top right-hand corner of the screen. Most settings are configured
automatically during installation and some settings may be managed after
installation. Itis important that changes are not made on this screen without a
good understanding of their meaning. Incorrectly setting some of the values on
this screen will cause LYNQ to stop working. In particular, please pay careful
attention to the database and integration settings when changing these
settings. Typically these settings do not need to be changed after LYNQ has
been installed

Section Field Meaning
General Company Name Site Display Name
Settings
Add ERP Append Database Name to site Name
Database Name
Localization Default Site Localization
Language Default Site Language
Administrator(s) Site Administrator(s) separated by semi
colon
Admin e-mail Administrators email address
Email Settings From From address for all Messaging
Alias Alias address for all Messaging
Server SMTP Server address
Port SMTP Port Number
Account Mailbox account
Password Mailbox password
Enable SSL SSL required/not required
Database Settings Source Database connection string details for

ERP Database

Data Database connection string details for
LYNQ Data Database

Config Database connection string details for
LYNQ Config Database

Logic Database connection string details for
LYNQ Logic Database

Automation Database connection string details for
LYNQ FA Database

Cache Database connection string details for
LYNQ Live Data Database

LYNQ api Settings Host LYNQ api site name

Service LYNQ api service name

Instance LYNQ api instance name
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LYNQ

Click  to read
this page online.
The online version
provides additional
links to other
related information.

In most cases general
settings will not need
to be changed once
LYNQ has been
configured.

LYNQ caches data
periodically for better
performance of the
application. Data is
read from Enterprise
Resource Planning
during the caching
process. Adjust the
values here if you want
to cache data more
frequently. Setting
these values too low
can be load on your
SQL server. You can
force caching of data
by selecting Refresh.
Data caching affects
the data you see in
reports and
dashboards
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Advanced Settings (General)

General settings are used to manage default application settings in relation to
data collection, display of decimals, group security and data management. The
application is shipped with these default settings.

To access General Settings:

1. From the LYNQ Home menu select Settings
2. Select Advanced Settings

3. Select General

General
Enable find as you type filter Enabled
Split equipment by primary type False

Data Collection

Employee status (default) Out/Off
Equipment status (default) Out/Off
Clock out warning after (hrs) 14.0
Terminal timeout after (secs) 600
Clocked time (default) Office Time
Data selector (default) Operation Selection
Report quantity (maximum) 1000000.00
Report scrap (maximum) 1000000.00
Supervisor workbench access True

Store data at lowest level True

Enable Automation False
Automation polling interval (sec) 10

Data buffer interval (sec) 60

Data Caching Interval (s)

Tasks 620
Tasks schedule 630
Operations 610
Materials 640
Jobs 600
Employees 3600
Equipment 3600
APS planning statistics 3600

Display Decimals
Hours

Quantities
Material quantity
Other

NN NN

Messages and Alerts
Validity period, days

w
(@]

Financial Loss
Labour rate 25.00
Employee revenue rate 125.00
Overhead rate 35.00
Equipment revenue rate 175.00
Financial loss currency

©
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LYNQ

Overview

In most cases general
settings will not need
to be changed once
LYNQ has been
configured.

LYNQ 2019 USER GUIDE

Advanced Settings (General)

False
False
MB
True

&)

Page 10 / 122



LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Overview

Stay informed and
check the overall
health of LYNQ by
using the Systems
Insight screen.

Please wait
Be patient with this
screen. It can take a

minute or two to run on

larger databases.

Troubleshooting

A great feature used by

support when
troubleshooting the
application at the
technical level.

LYNQ 2019 USER GUIDE

System insights

System Insights displays the current health and state of your LYNQ application.
This page is used by system administrators to troubleshoot and diagnose areas
of LYNQ that are not functioning as expected. The SQL account that is
specified in Settings, Database Settings must have SQL admin rights for this
page to function properly.

Any values on the page that are highlighted red should be investigated for the
continued operational health of LYNQ. This page provides at a glance a quick
way to identify if there are any underlying SQL views that are not functioning
correctly due to violation of key constraints. This is particularly useful when
the database of the Enterprise Resource Planning application that LYNQ is
connected to is set to a collation that is case sensitive. LYNQ is not a case
sensitive application and therefore SQL views may not execute if there are
duplicate keys returned.

One example of this is where two Product records have been created in the
Enterprise Reource Planning application that differ on case. LYNQ would treat
the value PRODUCTA and producta as a duplicated value. If duplicate keys are
returned by the LYNQ SQL views, the application will be severely affected and,
in some cases, partly or fully inaccessible by users. It is therefore important to
understand these limitations and monitor the health of the application to
ensure the application is fully operational.
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LYNQ

Don’t forget to backup
your databases and
put them in your
maintenance plans.

If you see a high
number of transactions
that have a status of
posting this might
imply that the
application pool
settings need to be
fine-tuned. Check out
our knowledge base
articles on this subject.

Data is read from
Enterprise Resource
Planning using LYNQ’s
proprietary views.
Sometimes these views
are customised to give
you some extra data
mapped through to
LYNQ. Be aware that
views can get
overwritten with an
upgrade. Best to let
LYNQ help you perform
your upgrade. You can
book us through the
support desk.

The LYNQ Platform
Windows Service
consolidates your
activity into
transactions. This
service may stop due
to heavy load on the
server or it failed to
start during a server
reboot. Check this
service is running on
the Web Server.

LYNQ 2019 USER GUIDE

System insights

Use the System Insights feature for a quick view of:

Tab Name

Dashboard

Logs

Events

Automation

Sub Name
Seats
Database Size
Top Table
Top View
Validation

Windows Service

Raw Data

Analytics

Events

Transactions
Transactions
posting SQL View

N/A

N/A

N/A

N/A

N/A

Purpose

No of licensed seats activated vs number of
seats purchased

Size in MB of the databases used by LYNQ
The largest table in LYNQ by size in MB
The largest view in LYNQ by number of rows
Views that duplicates or errors

Last date and time when the LYNQ Platform
service executed

No of raw data records waiting to be
processed by the LYNQ Platform service. A
high number of records indicates that the
LYNQ Platform service is not running
Status of analytical statistics with option to
recalculate.

Background processing of events from the
workbench and or factory automation.
Values in the Invalid and Accept Error fields
indicate there is any issue converted raw
events into transaction data.

Number of transactions generated by the
timesheet or workbench feature, split by
transaction status.

Transactions that are approved and waiting
to be posted to Enterprise Resource
Planning

List of all proprietary SQL views used by
LYNQ. This tab can be used to identify
views which have duplicate key values. Drill
down on the number of duplicates to
understand which data is causing issues
with the execution of the view

List of all proprietary SQL tables used by
LYNQ. This tab can be used to job order
tables by size and row count.

Access to different log files generated by
LYNQ

A report of all events received via factory
automation, Workbench and Actions in
LYNQ

A view of current factory automation signals
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Go Paperless

LYNQ supports a
paperless shop floor by
providing electronic
work instructions (EWI)
to the shop floor in
various forms (static
files, simple forms or
by providing links to
instructional videos).
The provision of online
document control
offers a
countermeasure to
operator shortages
involving
documentation helping
to eliminate time and
materials as a result of
paperwork trails

LYNQ 2019 USER GUIDE

Document library

Links can also be used to connect job orders, operations, employees and
equipment to online file document management repositories when regulatory
or other requirements demand version control, archiving and audit trails.

Links can further be used to display other types of files such as CAD drawings
in DWG or DXF file formats. All you need is to ensure that a suitable viewer is
installed on the tablet or the panel PC device where you want to view the files
from.

You can attach files and drawings in Word, Excel, PDF, JPEG, PNG or other file
formats to Jobs, Operations, Employees and Equipment. These files are
available to view only and cannot be changed.

Attaching a static file to a job order

Click on the Document Library

Click Job orders and then select the specific job record/s

Click Add File and select Add File to Job

Drag and drop or click to browse to attach your files to the selected

AN

jobs
5. Click Save

Attaching a static file to an employee

1. Click on the Document Library, Employees and then select the specific
employee record/s

2. Click Add File and select Add File to Employee

3. Dragand drop or click to browse to attach your files to the selected
employee

4. Click Save

Attaching a static file to equipment

1. Click on the Document Library

2. Click Equipment and then select the specific job order record/s

3. Click Add File and select Add File to Equipment

4. Drag and drop or click to browse to attach your files to the selected
equipment

b. Click Save
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Online Forms

Create online forms to
record basic
information and
checks during the
production process.
Note: this should only
be used where there is
no audit trail, version
control and/or
archiving requirement.
Where this is a
requirement see
working with document
management systems.

Excel & Work

Copy and paste from
Excel or Word
(formatting may
change)

LYNQ 2019 USER GUIDE

Document library

Attaching a simple form to a job

Click on the Document Library

Click Job orders and then select the specific job record/s
Click Add Form and select Add Form to job

Create your form or checklist in the WYSIWYG Editor
Click Save

I R

You can link to document management systems such as Qpulse® or
Sharepoint® (Microsoft Office 365) to view videos and work with controlled
shop packet information where audit trails, version control and archiving is a
requirement.

Care should be taken to organize your document library within your document
management system to make it easy for the operator, supervisor or manager to
work with.

For example, rather than link individual documents to specific operations, if the
document library is organized it may be easier to link to a shop packet library
for the specific job that contains all information such as videos, assembly
instructions, checklists, quality control forms and other controlled documents.

While this method requires a level of understanding from the user, it requires
far less administration and still ensures that only the paperwork related to that
specific job is used.

Linking to an online document library for a specific job

Click on the Document Library

Click Job orders and then select the specific job order record
Click Add Link and select Add URL to job

Place your cursor in the Link field

I

Copy and paste the URL from your document management system
library

Place your cursor in the Link Description field

7. Enter a description for the link (e.g. Shop Packet)

8. Click Save
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Versions

You should only import
a profile into LYNQ
when the source and
destination instances
are on the same
version number.

Backups

Save a copy of your
profile before making
any significant
changes to advanced
settings.

Config Database

An exported profile is a
textual representation
of the configuration
tables in XML format.

Factory Defaults

LYNQ is shipped with a
default profile and
loaded during
installation. Do not
delete this profile as it
can be used to reset to
factory settings.

Reset Profile

Do not reset your
profile unless you
really want to wipe all
of your settings.

LYNQ 2019 USER GUIDE

Storing your profile

Most of the settings configured in LYNQ are stored in the configuration
database. These settings can be saved as a profile and exported to file. This
is a really useful feature if you want an easy way to transfer configuration
settings to another instance of LYNQ.

For data integrity purposes, unfortunately not everything can be stored and
exported in the profile. Nearly all of the settings found in advanced settings
are exported. However, refer to the table below to understand what’s not
included in a profile export.

Feature Sub Feature Excluded
Seats Users Users
Seat Properties Settings such as photo, crew
and Factory Automation
Groups Seat to group relationships
which affect Alerts, Access
Controls
Terminals Linked Equipment
Transaction Rules Rules which are defined by
Equipment and/or Employee
Alerts Settings relating to measured
Resources
Workbench Onscreen Elements Setting related to associated
equipment and login as
equipment

How to export your LYNQ Profile

You may be asked by the support team to export your settings for
troubleshooting purposes or may use this feature to transfer settings from one
site to another. Complete the following steps to export your current settings.

Click on Settings, Advanced Settings

Click on the Profiles Tab

Click on Save Current

Enter a new name and description (i.e. Profile - Current System Date)
Click on Save

Select the profile that was saved in step b

Select Export to File

O N o ehds

The profile will be saved in your windows downloads folders

To export settings, the user must be a member of the Administrators Group.

Page 15 / 122


https://support.lynqmes.com/en-us/knowledgebase/article/KA-01592

LYNQ

Features

Look out for these
features in this section
of the user guide. For
advanced users of
Visual APS, refer to the
Advanced User Guide.

LYNQ 2019 USER GUIDE

Detailed scheduling

LYNQ provides detailed scheduling so your organisation can easily

Schedule multiple resources

Customise load of scheduling demand

Build customisable workflows for identification of scheduling
priorities

View powerful grids and views of job prioritisation

View high resolution calendar-based Gantt graphical planning
boards

Manually and auto schedule individual operations, sequenced
operations within a job and sequenced jobs with sub job hierarchies
Drag and drop schedule with enhanced impact behaviours
Forward and backward auto schedule with rule and priority-based
scenarios for scheduling optimisation

Semi-automatically reschedule late operations with autofit, shift,
replace, move and schedule around options

Fix jobs and period fencing (pinning)

Apply alternative resource scheduling with item/operation-based
constraints

Apply variable resource constraint consumption strategies

Apply what If and capable to promise (CTP) scenarios for capacity
and materials

Dynamic scheduling and execution alerts

Apply materials planning and availability analysis

Capacity plan

Publish and dispatch
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Reset Layout

You can reset the
layout back to factory
settings by clicking on
file, company settings,
and reset layout.

Task Panel Columns
Column settings are
saved in your Visual
APS profile that is
stored in your windows
user profile.

Imported Equipment
Equipment, which has
been imported from
your ERP, will appear
in the factory explorer.

LYNQ 2019 USER GUIDE

Navigating Visual APS

The Visual APS graphical interface is divided into three main sections.

e Factory Explorer
e Task Panel
e Schedule Board

Each section can be resized, pinned or moved around the screen as per your
desired preferences. The schedule board can be displayed on another monitor
to utilise the entire screen size.

Factory Explorer w B X | Production Jobz 41
m (= Drag 2 column header bere 1o §roup by that column
& ] | ske Descripsion
B | A " 2 : Quted? o \ voer v
B non S . Tov Prodocts Amach | On Hold | Materiais? | Operatic w | Scheduied? | Pinned?| Marksr | Work Order
| Satect | Work Cent| Description i 1 X L] WONAO120203
| > ) o

]  LABOOL  Assm Oper 1 X ° [ WONAD
[l LABO02  Milling Machine Opera 1 .4 ° ' WONAD 2

LABO03  Tourneur ! X ) [ WONAD120199 MKTEST-NAOL2
o LABOOS  Stockroom Amendant 1 )24 ° ' WONAD120138 MSTEST-NADI2
[l LABOOS  Opérateur Mécanigue |
Ll LABOOS  Régleur Production Jobs <41 Filtered! Sub Jobs MAP Jobs -0 What If fobs -0
[} LABOO7 Opérateur Injection e

Schedule |
Ll  LaB008 # —
L]  LABOD9  ‘Weiding Operator =1 FARR [
ol LABOIO  Packing B B
Ll 18091 WgnPunchOp 010000
C ) &00AM| S:00 AM| 1000 AM 1100 AM 12200 PM 13200 PM 14200 PM 150

L LAB092  WgnBendOp - - - -
Ll 18093  wgnOriOp A T :
™| LABO3S  Wgn Stamp Op LAZICS (2N "
Ll L8095  WinPamtOp [Emetem |

L LaB0%  WgnAmmOp
MACOOL  Ontreuse
MACOO2  Milling Machine MKC“S
MACOO3  Perceuse

L) MACOO:  Scie Automatique
[ MACOOS SciesRubsn

MACOOS  Tour Traditcnnalle | Macots

L MACDO? TowroN

Factory Explorer

The Factory Explorer Panel provides an outline view of the manufacturing
facility. A checkbox against the resource allows you to indicate whether it
should be displayed in the schedule board. They appear to the left of the board
in alphanumeric job order.

Task Panel

The Task Panel displays your job orders, dependant on the Job Import Rules
defined in Settings. Tabs show the total number of job orders currently
contained in its grid. The job order counter is dynamic and responds to a data
refresh, changes in the setting or filters. The column that you see in the task
panel can be customised by right clicking on the column heading.

Schedule Board

The schedule board displays all scheduling information related to the
resource and it's shift times and activities. The start and end date/time for
scheduled job orders are graphically represented. Vertical lines divide the time
bar in various increments.
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LYNQ

Features

Look out for these
features in this section
of the user guide. For
advanced users of
Visual APS, refer to the
Advanced User Guide.

LYNQ 2019 USER GUIDE

Navigating Visual APS

Quick Access Toolbar

The Quick Access Toolbar appears at the top left of the screen above the File
menu. It includes some of the most common commands for easy access.

e Save and Publish

o Refresh Data

e Unschedule Selected Items

e Highlight Job order

e Load Required Resource’s

¢ Unload All Resource’s

o Perform Auto Scheduling

e Show Resource Consumption

Ribbon Menu

Visual APS includes 9 different ribbon menus. Ribbon menus provide a fast
method of seeing and utilising functions in Visual APS.

This ribbon menu can be collaspsed to free up space for other windows. To
collapse the ribbon menu, right click on an area in the ribbon menu and select
Collapse Ribbon. To restore the ribbon menu, right click on a menu option on a
visible ribbon menu and select Expand Ribbon.

Planning Interval

The Planning Interval is the period specified in which you want to make
scheduling changes. Scheduling cannot be performed outside of the planning
interval. The planning interval can be changed at any time from the ribbon menu
The default planning interval setting may be set by user in the Visual APS
settings window.

Company

Visual APS supports multiple companies and it’s easy to know which company
you are logged into by viewing the company name next to the Welcome Tab
under the File Menu.
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Last Company

When you exit Visual APS,
company connection
information will be saved
within your windows user
profile. The next time you
open Visual APS, the
company will automatically
load. The load company at
startup setting in general
settings will determine
whether the last company
opened is loaded
automatically.

SQL Security

Refer to the Advanced
User Guide to
understand how to
setup security in SQL
for Visual APS.

Multiple Companies
It’s possible to open
multiple companies at
the same time.

LYNQ 2019 USER GUIDE

Opening a company

You can launch the Visual APS Desktop Client from the LYNQ home page or
directly from the shortcut on your desktop. You will need to contact your
systems administrator to obtain the correct Enterprise Resource
Planning database to connect to. You must also have been setup as a user in
Visual APS to use the application.

To open a company with Visual APS

1. From the File Menu, select Open

2. Click New Database Connection
In the Server field enter the name of the SQL server where Enterprise
Resource Planning resides

4. Select the correct authentication method as setup by your
administrator

b. Select the App Role security setting if turned on by your administrator

6. Inthe Company field enter the Enterprise Resource Planning database
name

Click OK to open the company

Open Database X

Scheduling interval frem: | 04/01,/2019

S [ ——
T | to | 0o/d3/2079

M

.

:| Server Company | Authentication Mode | From
|
-
[l (2]
Server I S0LserverMametnstanceMames l [:]
Authentication Security
\®) Windows Authentication Login LI App Role
\__/ SQL Server Authentication Paszword
Company | EPRDatabaseMa *n#
Mew Database Connection (=)
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LYNQ Rearranging the layout

Online Version You can rearrange the layout of Visual APS to suit your individual requirements.
Click here_to read Users with dual screens may prefer to show the schedule board on a second
this page online. screen.

The online version

provides additional How to Move the Factory Explorer, Task Panel or Scheduling Board

links to other

related information. 1. Select and hold the left mouse button on the window header. A colored

Reset Layout area indicates the window you are moving. Small icons indicate the

You can reset the possible locations to move the window.

layout back to factory 2. Drag the window to the new location on the screen. Point to one of the
settings by clicking on
file, company settings,
and reset layout.

icons to dock the window to that location. Or drag it anywhere to open
that panel in a separate window (floating).

Filtering How to Resize the Factory Explorer, Task Panel or Scheduling Board
Filters may be applied

for any column or 1. Point the mouse on the job order of the window until the resizing
columns in the task cursor appears.

panel. When a filter is

. 2. Click and hold the left mouse button and drag the job order as needed.
applied, the tab name

shows the number of 3. Release the left mouse button.

jobs followed by the

word filtered in red. How to Float the Factory Explorer, Task Panel or Scheduling Board

Task Panel Columns 1. Click on the small arrow at the top right of the window that you want to
Column settings are float

saved in your Visual oat.

APS profile, which is 2. Select floating from the menu. The panel is now in a separate window.
stored in your windows You can also simply double-click the window header.

user profile.
Imported Equipment How to Dock the Factory Explorer, Task Panel or Scheduling Board

Equipment, which has , . . ;
been imported from Windows are automatically docked. If you have previously floated a window,

ERP, will appear in the you can redock it by moving it to one of the docked locations indicated by the
factory explorer. small icons that appear when you move a window.

How to Auto Hide the Factory Explorer, Task Panel or Scheduling Board

1. Select the Auto hide icon on the right side of the window header.
2. The window is hidden on the side it was docked to. Hover over the

window name to see it or click on the name to open it.
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Hierarchies

The groups that you see
in the Factory Explorer
are read from Enterprise
Resource Planning
directly. The resources
that you see under the
group names are
typically imported by
running the Import
option from Visual APS.

LYNQ 2019 USER GUIDE

Factory explorer in more detail

You are able to manage the resources that you see in the schedule board by
using simple techniques below:

o Check the box next to a resource it in the schedule board.

o Check the box next to a resource group to view all of the associated
Resources in the schedule board.

¢ Uncheck the box next to a resource to remove it from the schedule
board.

o Check or clear the checkbox at the top of the factory explorer panel
(to the left of the column headings) to view or remove all resources
from the schedule board

It’s possible to restrict which resources a user is able to see.

To restrict access by user

From the File Menu, select Company Settings

Click User Access

Click By Planner

Select the User

Place check marks against the resources you wish them to see
Click OK

oo s 0N

In addition to restricting which resources a user can see, you also have the
ability to prevent any resource groups from being displayed where there are no
resources underneath them.

To hide resources groups where there are no associated resource

From the File Menu, select Company Settings

Click Designer

Click Hide resource groups where there are no associated resources
Click OK

Eal S
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Sorting Columns
Quickly sort columns
by clicking on the
column name.

Default Task View

By default, the task
panel will show the job
order and then the
operations underneath
them. To see the
operations you need to
expand each job order.
You can change this
view so that the task
panel shows a list of
operations instead. To
do this click on the
manage menu and

select list by operation.

Sub Job orders Tab
The sub job orders tab
will show a view, which
relates the sub job
order to its parent or
master job order.

Volume of job orders
The planning interval
does not affect the
volume of job orders
that you see in the
Task Panel. The
interval is used for
calculating your
capacity.
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Task panel in more detail

To change the job order of the columns in the task panel drag a column header
to a new location. Visual APS retains the changes and the task panel will again
appear in this job order when the software is reopened. A number of additional
columns are available and can be added to the task panel.

To add columns to the task panel

Right click on a column heading

Click Column Settings

Expand the required entity in the left window

Click on the + symbol

Customise the label of the column if required

Set the desired position by changing the number value
Click the arrow symbol to change column position
Click on OK

O No o s e

To remove columns from the task panel

1. Right click on a column heading
2. Uncheck the column in the right window
3. Click OK

The types of job orders that appear in the task panel are controlled by settings
in Visual APS. These settings are in the Visual APS profile which is stored in
the user’s windows profile folder. You can change which job orders are loaded,
whether job orders should only be loaded for a particular planner code and
whether job orders should be loaded within the current planning internal

To customise the types of job order that are loaded in the task panel

From the File Menu, select Company Settings

Click Job order Import & Rules

Click on the Production or MRP tab

Change the settings to show All, Scheduled Only or Excluded
Click OK

I
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Click to read
this page online.
The online version
provides additional
links to other
related information.

After you have spent
some time getting your
columns to look just as
you want them, why
not send your profile to
other users. You can
save you profile from
Company Settings.

Visual APS has a
number of different
User Defined Fields
that can be displayed
as columns. By
Default these columns
are not mapped to any
data fields in the
Enterprise Resource
Planning application.
Contact LYNQ Support
if you want to map
these fields to values
from your Enterprise
Resource Planning
application.
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Task panel column explanation

The task panel includes a number of different columns. Understanding the
most the meaning behind each of the columns will improve your experience of
the application.

The table below provides some explanations of most frequently used columns.

Field Name Description

Attach This provides the ability to add a document related to a job order
or an item. When a job order document is attached, a paperclip
icon is displayed in this column.

Materials? Provides a visual indicator as to whether materials are available at
the start date of the job order.

Operations? This round coloured symbol indicates if there is adequate
information for Visual APS to schedule the operation or job order.
Green = Valid for scheduling
Red = Cannot be scheduled
Yellow = Does not need to be scheduled
Grey = Needs to be validated (by clicking on the line)

Scheduled? This column is blank if a job order is not scheduled. When
scheduled, the graphic may be;
. Thumbs up with yellow cuff = scheduled/unsaved
. Thumbs up with green cuff = scheduled / saved
. Warning sign = partial scheduling of some operations

Pinned? Provides a visual indicator if the job order has been pinned. This
job order can no longer be moved unless the pin is removed first.

Marker Markers appear as user defined visual indicators that can be set
against job orders. Markers can be color coded and used for
sorting and filtering purposes.

Possible Available capacity for a resource may change when settings or
Errors shifts are amended. After saving amendments, a dialog box
appears asking if any job orders should be ignored, unscheduled or
marked as possible errors. This column will display a red circle
with an x as the possible error designation. The job orders or
operations should be verified. To remove this icon, use the resolve
possible errors function.

Scheduled When imported from Enterprise Resource Planning, this is the job
Start order/operation planned start date. This field will be updated once
the Job order/Operation is scheduled within Visual APS with the
actual scheduled start date.

Scheduled When imported from Enterprise Resource Planning, this is the job
Due order/operation planned due date. This field will be updated once
the Job order/Operation is scheduled within Visual APS with the

actual scheduled due date.

ERP Name The field name that you see will be your Enterprise Resource
Planning application name This field shows the original planned
scheduled due date from the Enterprise Resource Planning
application. This date does not change when the job order is
scheduled.

Job ordered The total quantity to produce on the Job order.
How many units have been produced against the job order.
Remaining Shows the difference between the job ordered quantity and the
reported quantity.

NI Ila-A=NCYA Shows whether the job order is running late based on its planned
schedule.
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Online Version

Click here to read
this page online.

Zoomi in and out

Use the + & - icons on
the top left-hand
corner of the schedule
board to zoom in and
out or alternatively
access the zoom in and
out functions from the
Review menu.

Changing Colours

You can customise the
colours of different
types of job orders and
tasks. Click on
Company Settings and
on Designer Settings to
change the colours to
suit your preferences.

Labels

You can change the
way job orders are
viewed on the
scheduling board. The
labels function
provides the ability to
view job orders broken
down by set up, run
and processing times
within the operation.
This is particularly
useful when
minimising
changeovers

Hide Completed
Select the Hide
Completed Operations
setting in Company
Settings, Scheduling
Routing Rules, Routing
to stop a completed
operation from
appearing and
consuming resources
on the scheduling
board.
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Schedule board in more detail

The schedule board is arranged into three horizonal sections. Immediately
below the date and time lines you will see:

o Resource capacity
e Resource availability
o Task sequence in blocks of time

Schedule |

8@ E G

+
8 020000 B —— — Y N
- w

- ) 8:00 AM 10:00 AM 12:00 PM| 14:00 P\ 16:00 PM| 18:00 PM| 20:00 PM| 22:00 PM| 0:00 AM

7 1 I T 7
NADIZ a1 V1

Resource capacity

The top line indicates the resource capacity defined by shifts. It displays the
work unit scheduled hours in coloured blocks for working / non-working or
other activities. In the example above the blue area indicates working the
blocks on the timeline that represents working time.

Resource Availability

The middle line presents resource availability at any point of time. This
information can be presented in %, quantity or coloured equalizer modes.
These options are represented by the following icons and views can be
amended by selecting the corresponding image. This option changes the
representation only for resource with the enabled resource mode.

SIERE

Task sequence in blocks of time

The bottom line displays scheduled tasks in blocks on a line in the sequence
they are scheduled. The tasks cover the time required for that item to be
produced. The time consumption is calculated according to the route
parameters of the resource (i.e., item units per hour, number of workers,
calendar rules, etc.).
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

A Better Experience
Shortcut keys can help
improve your user
experience. Take some
time to learn a few of the
most common ones.

LYNQ 2019 USER GUIDE

Shortcut keys

Some standard MS-Windows shortcuts are available for use in Visual APS.
These are optional and are primarily used from the task panel and other grids.

Program key combinations

CTRL+A Select all the items in the current grid

CTRL+C Copy the selected field

CTRL + R Refre§hes data from Enterprise Resource
Planning

CTRL + S Saves.or Updates Enterprise Resource
Planning

CTRL+Y Redo

CTRL+2Z Undo

Mouse key combinations

: e
CTRL button + mouse wheel scroll Changes the p.lz?nnmg ST A0S
point to a specific spot to zoom there

ALT + drag and drop scheduling Uses the Autoshift Function

Move a Task on the Planning Board to the
SHIFT + mouse wheel scroll closest limit (e.g. another scheduled task)
SHIFT + left mouse Task Panel selection of a group of jobs
CTRL + left mouse Task Panel selection of specific jobs
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Deleting Activites
Activities cannot be
deleted once they have
been created. Think
carefully before
creating these.

LYNQ 2019 USER GUIDE

Adding new activities

The work calendar is a combination of both activities and shifts which
represents the working hours, holiday calendar, breaks, plant shutdowns and
shift schedules. Before you can use LYNQ for detailed scheduling, you must
define a work calendar. Work calendars are configured within Visual APS and
are setup independently of Enterprise Resource Planning.

Before a resource can be available for scheduling purposes, the resource must
be associated with a Shift. Shifts are used to define the available capacity of a
resource. Shifts contain different activity types to identify working time from
non-working time and downtime. A shift may contain multiple activity types.The
default activity type included in the application are:

e Working time

o Non-working time
e Lunchtime

e Maintenance time

e Approved overtime
To create new activities

Click on the Home Menu

Click Activities

Click Add New

Enter a value in the Activity Code field

Enter a suitable description in the Activity Description field
Select a Color for the activity by clicking [...]

Click OK

Click OK

I R
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LyNQ Shifts

Online Version By default LYNQ is pre-configured with two shift patterns. These rarely suit the
Click here to read shift patterns for every manufacturer. New shifts can be created to suit new

this page online. operational requirements.
The online version

provides additional
links to other
related information.

To create a new shift

Click on the Home Menu

Click on Shifts

Click Add New

Enter a value in the Shift Name field

Enter a value in the Shift Description field

Making Changes

Click on the Home Menu
and then Shifts to edit your
default shifts.

Select the day of the week when the shift applies
Using the left mouse button drag to hightlight the time from and to.
Select the correct type of activity code for the shift

© 0o N ok whds

Repeat steps 7 & 8 to overlay different activities within the shift (i.e
lunch)

Edit Resources -

Shift Name | New Shitf Shift Description| New Shift

[P|EBSE left-click anywhere on day calendar range and drag with mouse to create new shift change. Please press right-click on day rule to edit it. |

Shift Change Code: | Sunday | [Total: Wrk 0:00 - nwirk 24:00 [ =] | Copy Shift Pattern

00] 01] 02] 03] 04] o5] o6] 07] o8] 0] 10] 11] 12] 13] 14 15[ 16] 17] 18] 18] 20[ 21] 22] 23]
[S:dNon\-‘."arking 12:00 AM - 12 0c1merking |

Shift Change Code: | Monday | | J .Ccpy Shift Pattern .

Activity Code: | ing - i

00] 01] 02] 03] 04] 05[] 06 oot Time: | 07:00 18] 20] 21] 22] 23

[S:d.‘vlon\"."orkmg 12:00 AM - 12:0

End Time: 19:00

Shift Change Code: | Tuesday :| Copy Shift Pattern
oo] 01 o2 03] 0a] 05[] 08, —————— T [19] 20] 21] 22] 23

[SszDnWarking 12:00 AM - 12:00 AM

Once you have created your new shift for a day, you can copy the same shift
pattern to other days in the week.

To copy the same shift to another day

1. On the day you want to copy, left click on Copy Shift Pattern
2. With the left click still activated, drag and drop the shift to the relevant
day

3. Repeat steps 1 and 2 for all days you want to have the same shift
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Rebuild
If you are not
immediately seeing

changes after updating

your work unit
properties, you may

need to tick the rebuild
check box on the work

unit record
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Assign a new shift to a resource

At any time, you can reset the shift against a resource. When the resource has
scheduled operations, you should decide how you wish to handle this before
changing the resource.

When changing a shift against a resource you wil be asked what to do with
existing scheduled operations

Your choices are:

e Nothing
o Unschedule operations
o Mark operations as possible errors

To assign a shift for a single resource

Right click on the resource in the schedule board

Click on Edit

Select a different shift in the shift column

Click Rebuild if a shift was previously assigned to the resoure
Click OK

Select how you wish to manage scheduled activities

Click OK

Noo s e

To assign a shift for multiple resources

Click on the Home Menu

Click on Work units

Select a different shift in the shift column

Click Rebuild if a shift was previously assigned to the resoure
Click OK

Select how you wish to manage scheduled activities

Click OK

Noo s e s
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Remove shift rule

To remove shift rules,
right click on the day(s)
in the calendar view
and select Set to
Default.
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Making shift changes (single)

At any time, you can make changes to a shift. There may be occassions where
you want to include non-working time into your shifts to relect shutdown or
holiday periods.

Shift changes can be applied to

e Asingle resource
e Multiple resources

To change the shift for a single resource

1. Navigate to the Factory Explorer

2. Expand the relevant site

3. Locate the work unit

4. Right click on the work unit

5. Click Shift (Change)

6. Click on Add New

7. Enter a value in the Shift change code field (i.e. shutdown)

8. Under the timeline left click and drag to highlight the time (i.e. 00:00
to 00:00)

9. Set the Activity Code to StdNonWorking

10. Click OK

11. Click on the heading Ungrouped from the Day Shift Changes task
panel

12. Right click on Shutdown

13. Click Copy

14. Select the dates (i.e 18th Dec to 1st Jan) by click/hold of left mouse
button

15. Right click on 1st January

16. Click Paste

17. Click Apply

18. Click YES to rebuild the calendar
19. Click Nothing

20. Click OK
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LYNQ Making shift changes (multiple)

Online Version Changes can be made to multiple resources at a time.
Click here to read
this page online. To change the shift for multiple resources

The online version

||°_"‘|3(ViOIes akc]jditional 1. Click on the Home Menu
rlenlafetg i:ﬁ‘o(:;ation. 2. Click on Changes
3. Tick the relevant sites and work units
Remove shift rule 4. Right click on the work unit
To remove shift rules, 5. Click on Add New
:;gr;ecggtaggsrsig;y(s) 6. Enter a value in the Shift change code field (i.e. shutdown)
and select Set to 7. Under the timeline left click and drag to highlight the time (i.e. 00:00
Default. to 00:00)
8. Set the Activity Code to StdNonWorking
9. Click OK
10. Click on the heading Ungrouped from the Day Shift Changes task
panel
11. Right click on Shutdown
12. Click Copy
13. Select the dates (i.e 18th Dec to 1st Jan) by click/hold of left mouse
button

14, Right click on 1st January

15. Click Paste

16. Click OK

17. Click Apply

18. Click YES to rebuild the calendar
19. Click Nothing

20. Click OK
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Remember to refresh
If you create any new
work units in
Enterprise Resource
Planning, remember to
refresh Visual APS
before you run the
import process.

What to import

You don’t have to
import all work units
into Visual APS. You
can be selective during
the import process

LYNQ 2019 USER GUIDE

Work Units

Resources are defined as personnel, equipment and/or materials. Resources
such as employees and work units are associated to shifts and help define your
production capacity. Resources are typically imported from Enterprise
Resource Planning and their settings can be extended further in LYNQ. Before
resources are available for scheduling, they must be associated to a shift. A
default shift can be selected during import of the resource from Enterprise
Resource Planning.

Primary and secondary resources are imported:

Order Data Type Imported To Imported From

Work Units Visual APS Visual APS
Tools Visual APS Visual APS
Employees LYNQ Website LYNQ Website
- Work Units LYNQ Website LYNQ Website
Tools LYNQ Website LYNQ Website

Open Visual APS
Click on the Home Menu
Click on Import

Eal S

If Visual APS recognises that there are new Work Units available for
import, a Work Unit dialog box will appear

b. At this point, you have the option to declare any default values for the
new Work Unit(s)

6. Click OK
7. Select the Work Units to import from the grid view
Click on OK
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Remember to refresh
If you create any new
work units in
Enterprise Resource
Planning, remember to
refresh Visual APS
before you run the
import process.
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Work Units

Once imported you will see the work units under the associated work centre in
the factory explorer. Note, if tools are supported by Enterprise Resource
Planning, these will be included in the import work unit process and can be
seen in the factory explorer under the work centre of Tools.

To import Work Units imported into Visual APS to LYNQ

1. From LYNQ select Seat Maintenance

2. Select Seats

3. Select Import

4. Select Import Equipment

5. Select the required Work Units

6. Select OK

7. Double click on the new equipment record to edit properties

8. Inthe group section, assign the work unit to the appropriate group

9. Click Active

10. Review and select appropriate value for "Planned availability
calculated by"

11. Click Save

To import Employees from Enterprise Resource Planning to LYNQ

Open LYNQ

Select Seat Maintenance

Select Seats

Select Import

Select Import Employees

Select the required resources

Select OK

Double click on the new employee to edit properties

©ooNe R Ld s

In the group section, assign the employee to the appropriate group

IS

. Review and select appropriate value for "Planned availability
calculated by"

11. Click Active

12. Click Save
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Rebuild

If you are not
immediately seeing
changes after updating
your work unit
properties, you may
need to tick the rebuild
check box on the work
unit record.
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Work unit properties

Visual APS allows additional properties to be set against a work unit. Refer to
the Advanced User Guide for Float resources and consumption settings.

Work unit properties

Section Field
Resources

Infinite Resource

Resource Type

Default Resource Qty

Float Resource Usage
Float Resource Usage Type

Float Discrete Resource
Usage

Min Resource Consumption
Max Resource Consumption
Recommended Load Level
(%)

Split Task Consumption
(Min)

Split Task Interruption (Max)

Shift

How to configure work unit properties

Value

Indicates no limits to capacity
Type of resource

Default No. of Resources
Float Resources based on Type
All/Less or Equal/Greater or
Equal

Float Resources based on
min/max

Min no. of resources required
Max no. of resources required
Recommended load level
percentage

Minimum time during which a
task can be started when
splitting tasks

Maximum time interruption
when splitting tasks

Default shift

1. From the Factory Explorer or Schedule board right click on the work

unit
2. Click Edit
3. Change the properties as required
4, Click OK
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Saving Calculations
User have the ability to
take a snapshot of the
material calculation
information. This can
be useful if additional
analysis needs to be
performed outside of
Visual APS against the
stock data. The data
relating to material
calculations is stored
in the Enterprise
Resource Planning
database in the LYNQ
stock info tables.
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Material availability

Visual APS provides a material indicator column in the task panel to indicate to
the planner, the availability of material for different types of orders. The
material indicator is updated whenever the calculate material function is run.
This feature can be run manually when the calculate method is set to manual
or when you open or refresh Visual APS when the calculate method is to auto.

Setting calculation method to manual or auto

Click on the Plan menu

Click MRP - Settings

Click on the General Tab

Select Manual or Auto from the Material Calculation lookup

Eal S

Due to the complexities of material calculations, setting Visual APS to
automatically recalculate can significantly slow down performance of Visual
APS. Every time Visual APS is refreshed and opened, Material Calculations are
performed. Therefore, it is recommended that the material calculation method
is set to manual, so the user can control when recalculations will occur

Setting calculation method to manual or auto

Click on the Plan Menu

Click Recalculate

Select Yes to save the current plan prior to running recalculate
Select production job orders Task Panel

I

The material column will now be updated
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Excluding or Including
The Planner can elect to
include or exclude job
orders, or reserve stock
in the calculations Visual
APS performs by clicking
on the Plan menu

LYNQ 2019 USER GUIDE

Material indicators

The Material Status Indicator appears against each job order in the task panel,
Double clicking on the Material Status Indicator will drill down to the Bill of
Material and provide an availability view for each component.

The same color coding is adopted throughout the Bill of Material. Drilling down
further on a specific component material status icon displays a list of job orders
that are consuming or replenishing the component. This can help you
determine which components may be shifted from another shop job order or re-
sequenced.

Indicator Meaning
x Mot included in matenal calculation

All matenals available at start date

Some matenals not available at start date

(¥ No Matenals available at the slart date

- All matenals available and reserved in the calculation

- Some matenals available and reserved in the calculation
iy No matenals available and reserved in the calculation

Job orders that have a yellow or red material indicator may require further
action. For example,you may not want to schedule a job order order where there
are known shortages. To identify which component(s) have a shortage, double
click on the Material Indicator to show the availability of materials by
component. Drilling down futher on the material indicator for the componet ill
show which job orders are consuming or replenishing the component.

When materials are attached to Operations, Visual APS provide greater
accuracy of material requirements. When an operation is not declared in the
Bill of Material the material required date is calculated for the start date of the
job order order. When specifying an operation for a component within a Bill of
Material, Visual APS will validate the material on the start date of the Operation
rather than the job order order. This is very important to help control inventory
as all the materials won't be job ordered too early for the capacity where they
will be used.
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Export to Excel

To inform procurement
of any shortages export
the overview reports to
excel.

MRP limitations

It is important to note
that the MRP and
Material

Availability functions are
not designed to replace
materials management in
Enterprise Resource
Planning. It is intended to
assist the planner during
the planning and
scheduling process. By
using markers, planners
are able to mark job
orders that have material
issues.

MRP shortages
Shortages are not seen
as a constraint in Visual
APS. Job orders with
shortages can still be
scheduled. To overcome
this, use the marker to
job orders with shortages
and excludes these job
orders during scheduling
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Material shortages

The MRP View feature in provides a stock enquiry of the current quantities for
components over a period of time.The MRP Views feature supports up to 100
periods by day or week.

MRP Overview

Each component used on a job order is returned in a grid view. The rows are
ordered first by location then by product. If Visual APS has calculated any
shortages for a component the quantity will be highlighted in red text. The
number of job orders affected by this shortage can be seen in the Job orders
affected column. Doubling clicking on the quantity value provides the user with
a drill down into the individual order details.

MRP Selected

Works in the same ways as MRP Overview but is useful for checking one or a
few job orders at a time.

To review shortages for all job orders

Click on the Plan Menu

Click Recalculate

Click on the Plan Menu

Click on Overview

Select the Period Type Day or Week

Enter the number of periods to review in the Period field

Nk e

Click on Apply
To review shortages for a selected job orders

Click on the Plan Menu

Click Recalculate

Highlight the job order you want to review from the task panel
Click on the Plan Menu

Click on Selected

Select the Period Type Day or Week

Enter the number of periods to review in the Period field

o N ok L d s

Click on Apply
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Settings

The settings you make
in company settings
are saved to your user
profile which is stored
in your windows user
profile folder. If you
want other users to use
the same MRP
settings, give them a
copy of your profile
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Material calculation settings

A number of setting are available to control how material calculations are
performed. Material status is calculated based on the supply and demand
settings within company settings, MRP import & rules.

Include Past Active job orders

Include past active ordrers is a setting that helps deal with job orders with a
due date less or earlier than today. These are considered already in the past
but may still be active. It is not possible to consume materials in the past, so
how do we want to see these job orders from a material viewpoint? Users can
completely exclude these job orders from the calculation (and you will see
those with an X) by not checking this box. Or users can include those job orders
in the material calculation but look at a different start date. By default, this
effective start date is set to today, or you can consider it into the future (i.e. +10
days).

This helps answer the question when will the materials for late job orders be
available? You should really reschedule these job orders for the date when they
will be kit clear or leave themas they are and enable material validation to
include them. If you include past active job orders, it is difficult to know what
is available tomorrow. So, the setting of "today" lets Visual APS know that the
job order is late but the replenishment will occur today and that material will be
available. The stock for tomorrow will include the past due quantities.

Group Locations

In Group locations the warehouse used in the calculation for material
requirements is read from the Bill of Material captured against the job order
order. Sometimes the stock on hand in the default warehouse is not enough but
stock may be available at another warehouse and you want to include another
warehouse in the material calculation. For that reason, Visual APS has a
function to group warehouses together. When grouping warehouses all stock
movements for the grouped warehouses can be viewed in the stock information
window
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Planning Interval

The planning interval
can be changed by
clicking on the
Schedule Menu. To
change the default
planning interval select
Company Settings,
Planning Interval.
These settings are
saved in your Visual
APS profile and only

apply t o you.
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Scheduling basics

The planning interval in Visual APS defines the period of time where scheduling
can occur. You cannot perform scheduling outside the planning interval. The
planning interval is defined under the settings area in Visual APS and saved to
the user's settings file. The Planning Interval can also be changed at any time
by going to the Schedule menu and select Interval. By default, this is set to 12
weeks. The interval for planning is visible in The Title Bar at the top of the
Visual APS window along with the server name, database name, and date and
time when the was was last loaded.

There are two primary methods of scheduling in Visual APS
Forward scheduling

e Forward scheduling takes a job order order with a number of tasks
and allocates those tasks to resources as early as possible, in other
words when resources become available. There is also an option for
Visual APS to schedule forward from a specific day.

Backward scheduling

o Backward scheduling takes a job order order with a number of tasks
and allocates those tasks to resources in reverse job orders, from
last to first operation, and schedules the task on the resource.

You can either manually drag and drop a job order or an operation onto the
schedule board or use the auto scheduling feature.

You can only schedule a job order or an operation when there is sufficient
resource capacity. By default Visual APS will try to schedule the resources that
are captured against the job order’s routing in Enterprise Resource Planning. If
insufficient resoures are available you may only be able to schedule the job
order partially or not at all. It's best to enable the schedule around function
when you want to schedule an entire set of operations for a job order. This will
enable you to schedule all operations together.

When using schedule around it is important to remember that operations will
only be scheduled when there is available capacity. If you drag and drop
operation 20 to a time on the schedule board which is right at the beginning of
your planning interval, any operations that come before operation 20 will not
be scheduled as these would need to be scheduled before the start of our
planning interval
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Markers

Visual APS allows you
to define multiple
markers to help
prioritise and
categorise your job
orders.

LYNQ 2019 USER GUIDE

Prioritising what to schedule

Understanding how production should be prioritised is an important
consideration for any manufacturer. All manufacturers have at least works job
orders, some of which are urgent, others of which are less so. Hence the need
to prioritise how job orders are scheduled. The priorities that are set, will
ultimately drive the schedule and is a main factor for how scheduled dates are
calculated.

To help prioritise job orders, Visual APS provides different features to help you:

e Markers

e Basic and Advanced Filters
o  Workflow Filters

e Grouping

Markers

o Markers appear as user defined visual indicators that can be set
against shop job orders on the task panel window. Markers can be
color coded and used for sorting and filtering purposes.

To create a new marker

1. Click on the manage menu

2. Click on markers

3. Click on the marker1 tab

4. Enteri.e. critical in the value field

5. Click on add

6. Click on the circle to the right critical
7. Click oni.e. red from the color palette
8. Clickon OK

9. Click on OK

To set a marker against a job order

1. From theTask Panel select the couple of job orders that are critical
2. Right click and select Markers

3. Click Marker1

4. Clicki.e. Critical
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Save filter to file
You can save your
filters and share the
xml file that is saved
with other users.

Save filter to menu
Saving filters to the
workflow menu is a
relatively new feature
in Visual APS. You can
now save your filters so
they appear just for
yourself or they can be
saved and used
globally by other users.

Filtering Columns
Columns can be
quickly filtered by
clicking on the arrow to
the right of the column
name.

Advanced Filtering
Right click on the
column heading and
select Filter Settings to
perform more complex
filtering. From the Edit
Filters windows you
can save the filter to
file or save the filter so
that it appears on the
workflow tab.

Grouping Tasks

Drag the column to the
area above the column
heading to group tasks
by column value
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Prioritising what to schedule

You can also sort job orders in the task panel. In the default view, the task panel
displays job orders by ascending job order number. In order to change the
presentation of the job orders, any column can be selected as the primary sort.
Select on a column header to sort the data according to that criteria. Select the
column header again to sort in the reverse job order. The arrow next to the
column header indicates the job order of the sort. Select a third time to remove

the sort.

Basic and advanced filters

The application provides two types of filters:

Basic filters are created from column headings and allow you to
manage which job orders are visible based on the chosen criteria.

Complex filters are used for multiple criteria selections and then the
filter can be saved and/or shared with other users or attached to the
workflow menu .

The use of filters allows you to prioritise job orders ready for scheduling.

To create a filter in the task panel

o N ok L d s

Right click on any column heading in the Task Panel
Click Filter Settings

Click AND

Click Add Criterion field

Select a column in the first field

Select an operator in the second field

Enter a condition in the value field

Click OK

To save a filter to file

9.

O No kLD

Right click on any column heading in the Task Panel
Click Filter Settings

Click AND

Click Add Criterion field

Select a column in the first field

Select an operator in the second field

Enter a condition in the value field

Click Save to File

Enter a file name and location

10. Click Save

1.

Click OK
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Online Version When creating filters you can save the filter as a workflow item.
Click here_to read
this page online. To create a workflow filter

The online version

provides additional 1. Right click on any column heading in the Task Panel
links to other 2. Click Filter Settings
related information. .
3. Click AND
Multiple groups 4, Click Add Criterion field
You can group on more 5. Select a column in the first field
Lzaar:jionr;e column 6. Select an operator in the second field
' 7. Enter a condition in the value field
Groups Resetting 8. Click Save to Menu
Groups are reset when 9. Select Who the Worklow will apply to
data is refreshed or )
N 10. Click Add New
when the application is
closed 11. Enter a Name for the Workflow
12. Click OK
13. Click OK
14. The filter will now be available on the Workflow Menu

Grouping can be used when scheduling job orders based on a particular
characteristic. For example, you may want to minimize change overs by
scheduling all job orders for the same product together..

To group job orders in the task panel
1. Drag the column heading to the top of the task panel

The data will be grouped by column dragged. Use the + and - icons to the left
of each grouping to expand or collapse the contents of the group. Sub groups
can be added by dragging additional column headings to the top of the task
panel.
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Valid Operations

To change the color of
the valid for scheduling
indicator from red to
green you must update
the job order order in
Enterprise Resource
Planning and refresh
the Visual APS data.

Drag and Drop

Visual APS takes you
automatically to the
first work unit to be
scheduled when
dragging the job order
onto the schedule
board

Not Scheduling

If you find you are
unable to schedule a
large batch of job
orders entirely, it's
likely your planning
internval has
insufficient capacity.
Either increase your
planning
,interval,reduce the
number of job orders to
schedule or increase
the number of
resources.
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Manual scheduling

Before operations can be manually or automatically scheduled, they must be
recognised by LYNQ as being valid for scheduling. The valid for scheduling
indicator must be green for Visual APS to schedule it. The indicator is displayed
on the task panel at the job order level and at the operation level.

You will notice that the valid for scheduling indicator will have mainly 3 different
colour codes. Each colour represents a different meaning:

1. Green meaning the operation has time to be scheduled

2. Yellow meaing the operation has already been completed by qty or
status

3. Red meaning Visual APS doesn’t know what resources must be
scheduled

The routing will define the number of resources required. When scheduling you
must have sufficient resources available. You will be able to see this on the
resource availability bar in the schedule board for a given resource. You can
quickly edit the number of resources by right clicking and selecting edit on the
resource in the schedule board.

To manually schedule, the planner is able to simply drag and drop either the job
order order or individual operations onto the desired slot on the schedule
board. This is particularly useful when a job order order is required to runon a
specific day or time.

To schedule job orders using drag and drop

Click on the Schedule Menu

Click on Schedule Around and check Left and Right
Click either forward or backward scheduling

Select a job order order from the task panel

Right click and select load required work unit

Click and hold the selected job order order

A o

Drag it down to correct time on the schedule board
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Scheduling Sequence
When the auto
schedule dialog
window appears if
grouping shop job
orders by grid grouping
the first job order to be
scheduled it will be the
one at the top of the
list. If grouping by
index, then scheduling
priority it will be from
lowest to highest
number.

Grid Grouping

The default grid
grouping setting can
be changed in
Company Settings,
Scheduling & Routing
Rules, Auto.
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Auto scheduling

Auto scheduling is one of two methods for scheduling job orders in Visual APS.
The production planner has full control over the sequencing of job orders and
is then able to use the auto schedule feature to place these onto the schedule
board. Auto schedule will ensure that job orders are scheduled in the
predefined job order in the next free slot based on the required and available
resources.

It’s possible to prioritise schedule job orders using two different methods:

e Grid grouping
e Priority index

To auto schedule by sequencing job orders using grid grouping

Auto Scheduling uses the sequence the job orders appear in the scheduling
grid to schedule them in order. It’s possible to drag rows up and down to
change the sequence of job orders.

Select a range of job orders to schedule

Right click and click auto schedule

Re-arrange the sequence by dragging job orders up or down
Click schedule by grid grouping

Click Schedule

Click OK twice

S e

To auto schedule by sequencing job orders using priority index

Each job order can be given a number of priority which will then represent the
job order in which these are scheduled on the schedule board.

Select a range of job orders to schedule

Right click and click auto schedule

Click schedule by priority Index

Click the job order that must take priority, and right click

Click Set Priority > 1

Click the other job orders that are not as urgent, and right click
Click Set Priority > 2

Click Schedule

Click OK twice

© Nk
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LYN Q Unschedule a job order/operation

Online Version Scheduled job orders and operations are easily unscheduled. There are a
Click here to read couple of ways to unschedule in Visual APS.

this page online.

The online version 1. Right click on the job order or operation in the task panel

provides additional
links to other
related information.

2. Click Unschedule or press delete on your keyboard

1. Highlight the operation on the schedule board
Planned Start/End 2. Rightclick and select Unschedule or press delete on your keyboard
When job orders or
operations are
unscheduled, the
planned start and end
dates will revert back
to the original dates

Once un-scheduled rememer to save and publish your changes to the plan to
update LYNQ and Enterprise Resource Planning.
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other

related information.

Pin Indicator

The Pin Indicator
shows in the task
panel and in the
schedule board

LYNQ 2019 USER GUIDE

Firming the plan using pinning

Visual APS offers the option to freeze job orders or operations to the production
schedule for a period of time, this is done using the Pin function. Pinning the
operations to the scheduling board means that those operations cannot be
moved or unscheduled unless you remove the Pin.

The "frozen" period will vary depending on the manufacturing environment but
it marks the boundary of which changes to the schedule be made, anywhere
outside this period job orders can be moved or re-scheduled.For example, a
company "freezes" the production schedule for 1 week. The Production Planner
and Production supervisor meet once a week to review the plan for the following
week and once agreed, its pinned to the scheduling board, meaning no one can
make changes to the plan unless agreed.

There are two ways to pin in Visual APS

e Pin (for selected job orders and operations)
e Pin Advanced (by date interval and work unit)

To use pin so no changes can be made

1. Click on the Review Menu

2. Highlight a job order, a range or job orders or an individual operation

3. Click Pin

4. Notice now that your selection will have a pin showing in the pin
column

b. Pinning can be reversed by click Remove Pin

To use pin advanced so no changes can be made

1. Click on the Review Menu

2. Click Pin Advanced

3. Set the Pin Interval from and to dates

4, Click the selected sites and or work units
5. Click Pin

6. Pinning can be reversed by clicking Unpin
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Save & Publish
Depending on the
Enterprise Resource
Planning application in
use, Visual APS will
either update the
scheduled dates on the
job order directly or by
using LYNQ api. The
integration settings
can be checked from
the home, settings
menu.
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Saving and publishing

The thumbs up image in the scheduled column will turn yellow when you
manually or auto schedule a job order. If the scheduled column does not
display the thumb icon, the job order has either only scheduled partial
operations or scheduling was not successful. When all operations are
scheduled and the scheduled column is yellow the order is virtually
scheduled. At this point Enterprise Resource Planning and data collection will
be unaware of the scheduled dates. You can at this point make any changes
before committing the schedule back to Enterprise Resource Planning.

Production Jobs -44

Drag & column header here ta group by that column.

* | Atach| OnHold | Materii|w | Operations?| Scheduled? [|Pinned?| Marker | Job Ciass Job Order Status Planner Location Product
3 N ® 2 000000000000528  Confirmed 4B SA B511
b N ® £00000 Confirmed B SA Ball
1 N ® 543 000000000 Confirmed 2B SA B311
3 N ® 000000000 Confirmed 2B SA B211
b N ® 000000000000524  Confirmed B FG B500
3 N ® 000000000 Confirmed B FG B500
: N ® 000000000 Confirmed 2B FG B400
3 N ® 000000000000521  Confirmed 2B FG B300

To dispatch the orders for data collection, the save and publish function must
be used.

To save and publish:

1. Select Save and Publish from the Quick Access Toolbar or
2. UseCTRL+S

Once published, the thumbs up image in the scheduled column will turn green.
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L\/NQ Capable to promise

Online Version The What-if job order feature allows you to create a job order that is not saved
Click here_to read within Enterprise Resource Planning so that you can estimate a production
this page online. unit's capacity without affecting any of the Enterprise Resource Planning data.

The online version
provides additional
links to other
related information.

Once created the what-if job order can also be scheduled, it may be determined
that a live manufacturing job order order should be created. The what-if job
order can then be unscheduled and remain on the task panel or it can be
deleted.

Capable to Promise To create a What-If job order
What-if job orders

provide an ability to 1. Click on the Schedule Menu
calculate capable to 2. Click on Add What If
promise dates 3. Select product number, Routing code, Location, Quantity and Date
4. Indescription 1and 2 reference for instance customer name and quote
number
b. Select OK.
Create Mew What-if Job
[tem Mumber I B100 l [ l
Routing Code | | - |
Location: |FE- | - |
Quantity | 100 |
Start Date 0&/08/201% B
Due Date 24/09/2019 O
Description 1 SAMPLE WHAT IF
Description 2 | |
[ Ok l [ Cancel l

Once the What-If order has been created it will appear in the What-If Jobs tab
under the Task Panel. The material indicator will show the availability of the
components for the What-If order. Double click the indicator to review the
earliest date when the material will be available. With this date known you can
now schedule the what-if order on that date.
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Re-Scheduling
Rescheduling can be
targeted to a specific
work unit. In order to
do this, Schedule
Around should be
turned off first, and
then only the targeted
work unit should be
loaded in the
Schedule. Whilst the
Calculate function still
calculates all
potentially late jobs, in
this scenario, only the
jobs for the selected
work unit will be
rescheduled.

Further reading
Check out the articles
in the knowledgebase
relating to
rescheduling
potentially late for
further information
support.lyngmes.com
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Calculating potentially late

Calculate potentially late highlights any job orders on both the schedule board
& the task panel that are in jeopardy of becoming late. Visual APS can calculate
which future operations are potentially going to be late, and can reschedule
those along with the operations already running late. The potentially late
function can only be executed you have enabled tracking from the settings
menu. This is located in Company Settings, Tracking.

Edit Settings x

¥ SETTINGS  Progress alerts

General || Show execution in job panels

User Access [+ Running late more than 0. 2%

¥ OB MANAGEMENT -
JOB MANAGEMET Row highlighting color: [ |E]

Y MATERIALS PLANNING ol Running early more than | 10. -] %

Row highlighting color: L | E]

Job Import & Rules

MRP Imparts & Rules
¥ FINITE CAPACITY SCHECULING

Designer (- Track changes

Planning Interval || Show when timeshift greater than

Scheduling & Routing Rules

—
[Resetsetrings] [Resel\ayaul] [ Load ] [ Save ] [ Quick save ]

To calculate potentially late job orders or operations

1. Click on the Manage Menu
2. Click Calculate from the Potentially Late options

Observe which operations have been flagged as potentially late (these are
highlighted in blue on the task list and have a blue vertical band to the left of
the operation in the Planning board).

To reschedule potentially late job orders or operations

1. Click on the Manage Menu
2. Click Reschedule from the Potentially Late options

Note that all Shop Job orders/operations highlighted during the calculation
process have now been virtually rescheduled. Any manual adjustments can be
made to the rescheduling proposal at this point. Once complete, select Save
and Publish to apply the changes.
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Crystal Reports
Reports are saved in
the application folder
and can be customised
if required. Be aware
that upgrades to the
application will
override any changes
made to reports. So
keep a backup of your
reports

Crystal Reports

All published reports
can be viewed from
your web browser.

Capacity Chart

The capacity chart is a
really useful tool for
the planner. Check out
the articles in the
knowledgebase
relating to the capacity
chart for further
information
support.lyngmes.com
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Dashboards and reports

There are a number of dashboards and reports available to support the user.
Refer to the table below for all the reports available in Visual APS.

Repor Report Name

Capacity Chart

Published Dashboard

Production Plan
Equipment Job order List
Materials List

Tracking Job order Status
Production History
Print Plan
Export Production Job orders
MRP Job orders
What-if Job orders
Reports Production Plan
Job order Ticket

Late Delivery
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LyNQ Dispatching

Future Activity LYNQ provides dispatching functionality to support the administration and
Dashboards and reports are coordination of schedules as part of Detailed Scheduling.

based on planned future

activity and provide insight Core features include:

as to how this will impact

your resources (equipment e Dashboard

utilisation) and your
product output (job order
fulfilment). e Equipment Plan

e Production Status

e Production Plan

o Material Lists

e Production Lists

e Equipment Lists

e  Production History
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Planned Utilisation
Planned Utilisation,
also known as loading,
considers the
proportion of calendar
time that has been
scheduled for
production (run time).
You can set whether
the scheduled hours
includes or excludes
setup, teardown and
processing time. By
default, these times
are considered as
downtime.

Planned Job order
Fulfilment

Tells you whether the
jobs that are due to
start have been
scheduled to start.
Based on the principle
that if a job has not
been scheduled to
start then it is unlikely
to be fulfilled
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Planning KPls

There are various references to key performance indicators in Planning. If you
can’t measure it, you can’t improve it... to increase your productivity and lower
production costs you need to benchmark your performance and minimize loss
within your manufacturing process.

Planned Utilisation

Calculation Scheduled Hours / Calendar Hours

Measure It is measured as a percentage (%). The higher the
percentage the better.

Report(s) Dashboard shows the planned equipment utilisation for the
selected equipment within the selected date range
Equipment Plan shows the planned equipment utilisation
for each piece of equipment. Each card can be drilled into
for further detail.

Planned Job order Fulfillment

Calculation Number of jobs scheduled / Number of jobs planned

Measure It is measured as a percentage (%). The higher the
percentage the better.

Reports(s) Dashboard shows the planned job order fulfilment for a
specific date range.
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Resources

The total number of
resources available for
the selected
equipment

Calendar Hours

The total number of
calendar hours for the
selected resources and
time period

Operating Hours

The total number of
shift hours for the
selected resources and
time period

Scheduled Hours

The total number of
planned productive
hours for the selected
resources and time
period
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Dispatching Dashboard

The dashboard located in dispatching, is used to balance equipment utilisation
and order fulfilment to maximise factory output. Order fulfilment considers the
number of planned job orders that are found within the selected date range
(start, end or spanning) and how many of those are:

1. Scheduled
2. In Progress
3. Late (did not start by the planned start date)

The plates are clickable allowing further drill down

18 13392 7812 4397 147 147 95 147

..........

To open the dashboard from Visual APS:

1.  Select the Reports Menu
2. Select Dashboard

If the dashboard is greyed out, the MOM integration settings have not been
configured.

To set the MOM integration settings:

Select the File Menu

Select Company Settings

Select the General Tab

Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
in the MOM Integration field

Eal S

To open the dashboard from LYNQ

1. Select Dashboard from the menu section Dispatching
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Gantt View

A Gantt chart by
operations and tasks
of your production
schedule.

List View

A list view by
operations and tasks
of your production
schedule
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Production plan

The production plan is an online view of orders that have been scheduled in
Visual APS, providing visibility of the plan for non APS users. The production
plan has a Gantt view for both operations and tasks and and can be viewed in
list format. The print plan option provides a shop packet style report to be
printed which supports barcodes.

roduction Plan [T e I ] ew ) ST
[ [
= &0 - WD o D i

| [ )

[Eoninse] [oommmesed  (mol
[
+eris Sk v Bl o3850 1450 [zezommomana]

149 0p:30 Item:BIKEAS | Adventure Bike, LW, Black 01:22.00 18.73

# & Bike, LW, Black Qtye] (162 0p70 HemiBIKEAS | Adventure Bike, LW, Black 0| [153.0p:70 1termBIKEAS | Adventure Bike, L, Black gt:20.80 /9.20 153 0p:70 Item:BIKEAS | Adventure Biks|

Progress indicators are updated in real-time, providing excellent visibility of
work in progress.

e GREEN centre - labour reported

e RED centre - labour hours exceeded
e BLUE bar - quantity reported

e RED bar - quantity exceeded

e RED vertical bar - issues

Double clicking on the order on the production plan, will show the job card. To
sort the production plan by date, use the List View and sort by start
date Sorting by start date provides a simple job order list view of the entire
schedule and what should be being worked on. You can of course filter and
customise this list to get to the information you want.

To open the production plan from Visual APS:

1.  Select the Reports Menu
2. Select Production Plan

If the production plan is greyed out, the MOM integration settings have not
been configured.

To set the MOM integration settings:

Select the File Menu

Select Company Settings

Select the General Tab

Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
in the MOM Integration field

Eal S

To open the production plan from LYNQ

1. Select Production Plan from the menu section Dispatching
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LyNQ Equipment plan

Online Version Review the impact of the production plan on your equipment. Drill into each
Click here_to read equipment card to view loading detail and expected daily output.

this page online.

The online version e “OT” = Operating Time (Shift Time)

provides additional
links to other
related information.

e “PT” = Productive time
e “DT” = Downtime

Pu rpose Equipment li[a"n

Review the impact of
the production plan on
your equipment. Drill
into each equipment
card to view loading
detail and expected
daily output

l 7 I

DEPTC/WC3 OEPTC/WC3.A

DEPTB/WC2A

Card View

Displays graphical
summary of equipment
selected. Clicking on
equipment card takes 2. Select Equipment Plan

user to extended

details of equipment If the equipment plan is greyed out, the MOM integration settings have not been

loading configured.

To open the equipment plan from Visual APS:

1. Select the Reports Menu

List View
Line by line report by
equipment. From here

To set the MOM integration settings:

users can click on the 1. Select the File Menu

Equipment name to 2. Select Company Settings

view e>.<tended det?HS 3. Select the General Tab

of egL.upmen’F Ioac.img 4. Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
Additionally in this

view. there is a link to in the MOM Integration field

view the schedule for

each piece of To open the equipment plan from LYNQ

equipment. Below each

column heading there 1. Select Equipment Plan from the menu section Dispatching

is a search/filter

box. The pin next to
the search box
provides a set of
filtering options.
Additionally, in List
view there is
functionality to export
reports, create custom
filters and customise
layouts
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

List View

Line by line report by
job order. From here
users can click on the
Job order number to
view Job order Card
details. Below each
column heading there
is a search/filter

box. The pin next to
the search box
provides a set of
filtering

options. Additionally,
in List view there is
functionality to export
reports, create custom
filters and customise
layouts. The bottom of
the report shows the
number of items in the
report and the number
of pages. Page size
can be adjusted to
display up to 200 rows

per page.

Sub Order View
As per the list view but
with sub job orders
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Production status

Review open job orders to check their status. Use progress bars to gain visibility
of hours booked, materials issued and overall progress at a glance. Drill to view
specific job order details including attached documents and issues recorded.

Order Status ST Tomr e o [P | v Trwmm T e

‘
cooceccoooe ¢

To open the Production Status from Visual APS:

1. Select the Reports Menu
2. Select Production Status

If the Production Status is greyed out, the MOM integration settings have not
been configured

To set the MOM integration settings:

Select the File Menu

Select Company Settings

Select the General Tab

Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
in the MOM Integration field

N

To open the Production Status from LYNQ:

1. Select Production Status from the menu section Dispatching
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LYNQ Material list

Online Version View specific material requirements by individual resources for today or this

CI.iCk heito.read week designed to support cell manufacture and for use with mobile and/or
this page online. tablet devices.
The online version

provides additional Material List - DEPTA { WCL.B O e
links to other E——
related information. | == —

List View

Line by line report of
Material

requirements. Click
the arrow to the left of
a Material code to view

list of job orders o
requiring that To open the Material List from LYNQ:

material. From here
users can click on the 1. Select Material List from the menu section Dispatching
job order number to
view Job order Card
details. Below each
column heading there
is a search/filter

box. The pin next to
the search box
provides a set of
filtering option
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

List View

Line by line report
(grouped by
equipment) of job
orders. Click arrow to
left of Equipment name
to expand job order
list. Click on Job order
number to view Job
order Card details.
Below each column
heading there is a
search/filter box. The
pin next to the search
box provides a set of
filtering options.
Additionally, in List
view there is
functionality to export
reports, create custom
filters and customise
layouts
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Production job list

View job order lists by resource groups for today or this week designed for use
with mobile and/or tablet devices.

Production Order List - DEPTC [ er==

To open the Production Job List from Visual APS:

1. Select the Reports Menu
2. Select Production Job List

If the Production Job List is greyed out, the MOM integration settings have not
been configured.

To set the MOM integration settings:

Select the File Menu

Select Company Settings

Select the General Tab

Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
in the MOM Integration field

AN

To open the Production Job List from LYNQ:

1. Select Production Job List from the menu section Dispatching
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

List View

Line by line report
(grouped by
equipment) of job
orders. Click arrow to
left of Equipment name
to expand job order
list. Click on Job order
number to view Job
order Card details.
Below each column
heading there is a
search/filter box. The
pin next to the search
box provides a set of
filtering options.
Additionally, in List
view there is
functionality to export
reports, create custom
filters and customise
layouts
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Equipment job list

View of job order lists by individual resources for today or this week designed
for use with mobile and/or tablet devices.

Equipment Order List - DEPTB f WC2.A D oo

To open the Equipment Job List from Visual APS:

1. Select the Reports Menu
2. Select Equipment Job List

If the Equipment Job List is greyed out, the MOM integration settings have not
been configured.

To set the MOM integration settings:

Select the File Menu

Select Company Settings

Select the General Tab

Enter the URL of the MOM Site (i.e. http://webservername/lyngmom)
in the MOM Integration field

AN

To open the Equipment Job List from LYNQ:

1. Select Production Job List from the menu section Dispatching
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

List View

Line by line report by
job orders. From here
users can click to the
left of the job order
number to view
transaction details of
the job order. Notes
can be added to

transactions from here.

Below each column
heading there is a
search/filter box. The
pin next to the search
box provides a set of
filtering

options. Additionally,
in List view there is
functionality to export
reports, create custom
filters and customise
layouts.
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Production history

View activity history in relation to both open and closed job orders.

Production History

To open Production History:

1. Select Production History from Dispatching

Page 59 /122



https://support.lynqmes.com/en-us/knowledgebase/article/KA-01629

LyNQ Resource management

Features LYNQ provides resource management to support the administration of
Look out for these information relating to resources required for manufacturing.

features in this section

of the user guide. Core features include:

e Seat Maintenance
e Resource Maintenance
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Click  to read
this page online.
The online version
provides additional
links to other
related information.

The license for LYNQ is
stored in a sub
directory of the LYNQ
website folder. Once
applied all users will be
able to see the new
license details.

LYNQ is shipped with
some default roles. If
these do not suit your
organisation, you can
create new ones.

LYNQ 2019 USER GUIDE

Seat maintenance

It’s often the case that all users require access to LYNQ, unlike Visual APS and
LYNQ api which is accessed by a smaller group of individuals. Seats need to be
maintained in all 3 components separately.

Your license dictates the number of seats you can activate.

Built-in rights, roles and groups are shipped with the application. They provide
you with varying levels of security permissions out of the box which are
associated to a group which can be customized to suit your organizational
requirements. Groups are effectively a representation of your organizational
structure. You can add or remove users to or from any built-in group or any
groups that you create. You can also add or remove rights assignments to built-
in roles or your own roles except for the administrator role. Before a user can
access areas of the application, the user must be assigned to one or more
groups. Seats are a collective term for resources such as users, employees and
equipment. Users are managed under seats.

Let’'s take a look at the Seat Maintenance feature under Planning
Administration in more detail.

Menu Sub Name Purpose
Seat Seats A collective term for resources such as
Maintenance users, employees and equipment.
Rights Rights are used to assign permissions
to a role. Rights cannot be amended or
deleted.
Roles Roles comprise of one or more built-in

rights. You can create your own roles
to suit the responsibilities within your
organization. Groups can be
associated with one or more roles. The
built-in roles shipped with the
application and their associated rights
include:

Groups Groups are used to organize seats into
a hierarchical structure which models
those found in your organization.

Crews Seats can be assigned to a crew.

Crews can be used in workbench for
data collection purposes.
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Resources

It’s possible to create 3
different types of resource;
users, employees and
equipment.

Activate

You will see a message ‘no
seat assigned’ if you do not
activate your seats.

Not enough seats

Users and employees can
be linked so they do not
consume two seats. This
will help to reserve seats for
other users. If you need
more seats contact the
service team.

LYNQ 2019 USER GUIDE

Users seats

To access LYNQ a user seat must be created for the user. Users are associated
to active directory accounts. Application security rights are related to the group
the user is a member of.

If the user requires access to the workbench and/or timesheet functions and/or
you want to collect OLE data for the user, you must create an associated
employee seat. Equipment seats can be created in situations where equipment
is linked to a workbench and OEE is required.

How to create a new seat in LYNQ for a user

From the Planning Menu, select Seat Maintenance
Click Seats

Click New

Click New User

In the Login field enter the domain user account name
Click Find

Click Save

Click Close

Double click on the new employee to edit the properties

© o Nk

S

. In the group section, assign the user to the correct group
. Click Active
Click Save

—_—
N =
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Importing

When importing an
employee, the
workbench ID will
automatically be set to
the employee number.
Once activated, the
employee can clock
into the workbench
using their employee
number.

Deactivating seats
When you deactivate a
seat you will to be able
to re-use them for data
collection purposes.
Be aware that deleting
a seat may lose the
history for the seat.
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Employee seats

Resources such as employees and equipment records can be imported from
your Enterprise Resource Planning application or created locally within LYNQ.
It’s suggested that records are imported where possible to reduce additional
maintenance. When importing records, employees are imported directly from
the Enterprise Resource Planning application and no further steps are required.

The steps below explain how to import employee resources from your
Enterprise Resource Planning application and also how to create resources
directly in LYNQ.

Importing employees and work centres into LYNQ from your Enterprise
Resource Planning application

1. Select Seat Maintenance

2. Select Seats

3. Select Import

4. Select Import Employee or Import Equipment

b. Select the required resources

6. Select OK

7. Double click on the new employee or equipment to edit properties
8. Inthe group section, assign the user to the correct group

9. Click Active

10. Click Save

How to create a new seat in LYNQ directly for an employee

Select Seat Maintenance

Click Seats

Click New

Click New Employee

Enter a value in the First Name field

Enter a value in the Last Name field

Enter a value in the Workbench ID field

Enter the related Enterprise Resource Planning employee code in the

O N o

Employee ID field
9. Click on Save
10. Click on Close
11. Double click on the new employee to edit properties
12. In the group section, assign the employee to the correct group
13. Click Active
14. Click Save
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Importing

If you try to import
equipment in LYNQ
without first importing
the equipment in
Visual APS, the
equipment will not be
available for import.

Local equipment

You can manually
create equipment
records in either Visual
APS or LYNQ. The
steps are the same as
creating a local
employee record

Activated

When an equipment
record is active the
equipment can be used
for OEE purposes.
Additional functionality
in the workbench will
be turned on.
Equipment
transactions are
generated for active
equipment and you
have the ability to
record downtime
activity to support OEE
and TEEP calculations.
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Equipment seats

Equipment must first be imported in Visual APS and then imported into LYNQ..

LYNQ maintains a relationship of equipment records between

both

applications. An equipment record will be created based on where the

equipment belongs to. If the equipment is reorganised in your Enterprise
Resource Planning application, the equipment record should be deleted and re-
imported in Visual APS and LYNQ. If you try to import equipment in LYNQ
without first importing the equipment in Visual APS, the equipment will not be
available for import.

How to import equipment from Enterprise Resource Planning into Visual APS

o N ok LD

Refresh Visual APS

Click on Home

Click on Import

Set the Resource type to Machine - Machine Hours
Select the correct shift for the machine

Click on OK

Expand the site and select the correct work unit
Click on OK

Importing equipment from Visual APS into LYNQ

© o Nk

S

From the Planning Menu, select Seat Maintenance

Select Seats

Select Import

Select Import Equipment

Select the required resource

Select OK

Double click on the new equipment record to edit properties
In the group section, assign the user to the correct group
Click Active

. Click Save
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LYNQ

Click  to read
this page online.
The online version
provides additional
links to other
related information.

Personalise your
resources by giving them
photos. It looks really
cool in the workbench
and on status pages.

Watch out for this
setting. It can affect
what you see in some of
the dashboards and
reports that show the no
of resources.

Watch out for this
setting. It can affect
what you see in some of
the dashboards and
reports that show the no
of resources. If you are
using Visual APS,
equipment resources
should be set to V-APS

LYNQ’s factory
automation feature
allows data to be
collected automatically
from a resource. Refer
to the Advanced User
guide for further details
of this powerful feature.
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Resource maintenance

LYNQ allows for additional properties to be set against resources. Properties

can be set for

e Employees

e Equipment

To edit the properties for a resource

1. Open LYNQ
2. Click on the Resource Maintenance menu

3. Double click on the resource

Section

General

Capacity

Workbench

Field

Active

Photo

Crew

First Name

Last Name
Display Name
No. of Resources

Planned Availability
Calculation

ID
Password

Time zone offset

Group Name

Value

Seat is active/inactive
Photo of resource
Default crew for resource
Resource’s first name
Resource’s last name
Resources display name
Default no. of resources

Clocked Time

Availability is calculated as relation
between actual Up time to actual Total time

Basic Calendar

Availability is calculated as relation
between actual up time to basic calendar
value of planned hours for a specified day.

V-APS Resource Calendar

Availability is calculated as relation
between actual Up time to Planned Up as
per V-APS schedule for specified Work

unit/Machine

ID for accessing the workbench

Password to access the workbench

Difference between resources time and the

LYNQ server time

The group the resource belongs to. Groups
are integrated with messaging and alerts
and can also be used to restrict certain
functionality within the workbench.
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LYNQ

Features

Look out for these
features in this section
of the user guide.
Refer to the Advanced
Uses Guide to
understand the factory
automation feature.
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Data collection

Frontline managers need complete visibility and control of the shop floor to
prevent problems. Collecting data by conventional methods can be
complicated, time-consuming and expensive.

With LYNQ'’s configurable shop floor data collection (SFDC) terminals you are
able to gather time, attendance and production data from your employees and
equipment easily from any device with a browser. Clocking terminals and
interactive job lists simplify the execution of production plans and data capture
of start and stop times, downtime, labour hours, materials issued, quantities
reported, scrap and more.

Core features include:

e  Workbench
e Timesheet
e Factory Automation
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Unlike the Timesheet
which is used to
manually enter
transactions, the
workbench provides a
stop clock approach to
tracking time. Itis an
extremely accurate
way of tracking
employee and
equipment time.

The workbench is
highly configurable.
Refer to the advanced
user guide for further
information.
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Workbench

The workbench feature provides real time tracking of your factory’s activities.
Designed to interact with manufacturing workers and equipment on the shop
floor, the workbench typically runs on portable devices such as tablets and
iPads but can still be run on computers and laptops. As LYNQ is a fully web
enabled application, users can access the workbench from any remote location.
Whether this is from a separate factory location or whilst on the move from a
mobile device, the workbench is a scalable and flexible data collection solution.

The workbench layout is divided into 3 distinct sections.

Area Purpose

Header Navigational area for switching between
employee/equipment

Lookup option to select additional equipment
Color coded live activity status

Grey Bar - undefined activity

Green Bar - setup activity

Yellow Bar - setup, teardown, wait activity

KPI information relating to employee/equipment
Live message center new message indictor

Quick navigation to the workbench clock-in screen
(HOME)

Body Task list filtered by period:

(I NIGEIARE WM Active task(s) for employee

Scheduled task(s) by equipment

Buttons to perform functions set by the terminal
configuration

Green Buttons - functions for employee

Grey Buttons - functions for equipment (data collection
enabled)

The workbench will behave differently depending on the whether the
equipment is activated for data collection. The Active Yes/No setting against
the equipment record, will determine the functionality available to the user and
the level of data that is captured for analytical and tracking purposes.

Key differences between data collection activated equipment

Active Behavior

Yes Both employee and equipment transactions are
generated

Analytical data to support OLE/OEE/TEEP

No Only employee transactions are generated
Analytical data to support OLE
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Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Password Protect
Terminals can be
password protected
and multiple users can
access the same
terminal from multiple
locations.
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Start your day

Start day may be performed from either an entrance/clock-in terminal or a shop
floor data collection terminal. When the employee selects the function to Start
Day, the date and time is recorded as the start of their office time.

Using the example below, an employee enters the building and immediately
clocks in to the entrance terminal and progresses to Start Day. The employee
then takes 10 minutes to walk to his actual place of work. 5 minutes later, he
starts his first task of the day. During this time LYNQ has calculated his total
office time as 15 minutes.

08:00 08:10 08:15

Clock In and Clock In to Start Task
Start Day Assembly arttas

Using the example below, an employee enters the building and takes 10
minutes to walk to his actual place of work. He clocks into the Assembly
terminal and selects the function to Start Day. 5 minutes later, he starts his first
task of the day. During this time LYNQ has calculated his total office time as 5
minutes.

Clock In to
Assembly/ Start Task
Start Day

Clock in to start your day using the entrance terminal

Click Workbench

Click Terminals

Click Entrance

Enter a valid employee ID that is activated
Click Login

LYNQ

o s N

MICHEL

ROY
9

Clocking In
01:48¢m

<< Clock Out
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Clocked in Status
Unless configured
otherwise, the
employee will only be
able to send and
receive messages
within the workbench
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Messages

Once clocked into the workbench an employee will have instant access to
messages that have been sent and received to/from their immediate line
manager. It's advisable to review all messages prior to starting any work
activities for the day. If there are any unread messages the mail icon will appear
orange to alert the employee to check their messages.

The following steps describe how to send messages

Select Messages.

Select New.

Enter a value in the subject field.
Enter a value in the body field.
Select Send.

o s N

The message will be sent automatically to the employee's line manager. The
message center indicator will change color on the line manager's screen to
indicate they have a new message.
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Task Colours

The colours of different
task types can be
customised under
advanced settings,
definitions, diversions.

Continuous tracking
You do not need to
keep the browser open
to track labour. Even
after closing the
browser, LYNQ will
continue to track
hours.

Stopping tracking

To stop the tracking of
employee or equipment
hours, select stop task.
The end day function
will also stop tracking
hours for running
tasks.

Multiple Tasks

If your configuration
allows you are able to
start multiple tasks.
How time is allocated
between these tasks is
determined on your
advanced settings.
Refer to the advanced
user guide for further
information.
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Starting and stopping a task

The workbench splits operations into tasks. You can have more than one task
for an operation. This may be the case when your operation involves both setup
and runtime time elements. Instead of seeing just one task with both time
elements, you will see two tasks. This allows you to manage operations at a
granular level.

Tasks can be started by selecting a scheduled task from the equipment job
order list or by clicking on the add task option in either the employee
workbench or the equipment workbench. LYNQ is configured to automatically
start job orders on the planned equipment when an employee starts a task from
the employee workbench. The reverse behavior will happen if an employee
starts a task from the equipment workbench.

Labour and equipment time will be captured from the moment the task is
started.

To start a scheduled task from the equipment job order list
Click on chosen linked equipment in the workbench.

Click Turn On

You will now see tasks scheduled for this equipment
Click on the task you want to start

Click Start

AN

Once the task has been started you will see an indicator against the task in the
workbench showing that either the employee and/or equipment is running the
task. In addition the employee or equipment in the header section will have a
coloured vertical line to the left of the image to indicate what type of task is
running.

Starting an un-scheduled task

1. Click Add Task
2. Click on the task you want to start
3. Click OK

Stopping a task

1. Click on the task you want to stop
2. Click Stop
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Report Multiple

You can select multiple
job orders when
reporting a quantity.
The report screen will
move to the next job
order once reported.

Report Screen

The report screen can
be customised if you
wish to see additional
fields. Refer to the
advanced user guide
for further details.

Reject Codes

The reject codes that
you see in the
dropdown box should
mirror the reject codes
you have in Enterprise
Resource Planning

LYNQ 2019 USER GUIDE

Report operational quantity

Quantities for an operation are entered using the report function. The task in
the workbench will show the number of remaining quantities to complete for
that particular task. Quantities can only be entered for runtime operations.

L
o
Y

rt Stop Report Attachments

You can report good and bad quantities throught the report function.
To report good quantity completed

Click on the Task
Click Report
Enter the appropriate quantity in the Quantity field

AN

Click on Report

The Qty (Today) column is updated, and the remaining quantity column is
reduced by the good quantity reported. A transaction for the quantity will be
created and can be seen in the Transaction Review screen.

To report bad quantity completed

Click on the Task

Click Report

Enter the appropriate quantity in the Reject field
Select a reject reason code

Enter any additional comments

oo s 0N

Click on Report

The reject (Today) today column is updated, and the remaining quantity column
is reduced by the bad quantity reported. A transaction for the quantity will be
created and can be seen in the Transaction Review screen.

LYNQ provides an option to report materials as you report quantity. When this
setting is enabled, the user is automatically directed to issue materials after
reporting a quantity if material is attached to the operation. See the section
Report Material Issues for further information.
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Re-open Operation
Don’t forget report
status can be used to
re-open a completed
operation

LYNQ 2019 USER GUIDE

Report status complete

The status field on the report screen allows you to change the status of a task.
The options for changing status are

e Nochange
o Complete
e Re-open

When a task is processed as complete the task will disappear from the
workbench screen and a new transaction for a status change is generated.

When a task is processed as re-open the task will re-appear on the workbench
screen and a new transactions for a status change is generated.

To report a task as complete

Click on the Task
Click on Report
Select Complete from the Status lookup

AN

Click on Report

To report re-open a task

Click on the Task
Click on Report
Select Re-open from the Status lookup

AN

Click on Report
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Abnormal Tracking
LYNQ may be
configured to
automatically prompt
you to raise a
production issue if you
are reporting slower or
faster than expected
runtime. The track
abnormal progress
setting in advanced
settings controls this
behaviour.
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Report production issues

Production issues can be raised at any time through the workbench. Employees
can quickly raise issues using the pre-defined issue types. Issues are visible
form the Issue Log screen and any other relevant screens that the issue relates
to. Depending on your issue management process you may consider whether
you allow employees to raise production issues from the Workbench.

Predefined production issues include:

e Breakdowns

e Health & Safety

e Minor Stops

e Production Rejects

e Reduced Speed

o Setup & Adjustments
e Startup Rejects

To manually raise a production issue:

Click production issue

Click on a type of issue

Click on an issue

Select the appropriate task from the task lookup field

Select the specific work unit from the equipment lookup field
Select the employee from the employee lookup field

Enter a value in the hours field

Enter a comment in the comments field

Click OK

I N U

Once the production issue is raised by the employee, it will appear in the Issue
Log. Unresolved issues will be indicated by an orange circle above the issue
log menu. Once resolved the orange circle with disappear.

It’s also possible to raise production issues automatically from the equipment
workbench with the alerts feature. For further information refer to the
advanced user guide.
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Bins, Serials & Lots
You must specify when
reporting, any
additional attributes
for material. This is
important in cases
when the material is
lotted or serialised or
when the material is
stored in a bin
location.

Extended Details
Columns will only
appear for data that is
required. You must
split the entry by
quantity if the lot
number, serial number
or bin is a unique
value.

Validation Rules
Validation rules
determine whether you
are able to enter
material or kit issues
without specifying
extended details.
Refer to the advanced
user guide for further
details.
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Report material issues

Material can be reported from the workbench. Materials are associated to the
job order or operation and captured when the job order is created.

There are two different functions available to issue materials

Material Issue to issue against the select job order or operation
Kit Issue to issue against multiple job orders and by parent gty

To perform a material issue

o s LN

Click on a Task

Click Issue Materials

Click on the relevant job order in the header section

Enter a quantity in the Issue Materials field

If the material is binned, lotted or serialised click the extended details
button to the right of the quantity field

Enter the correct extended details such as serial number etc.

Click OK

To perform a kit issue

o s N

Click on a Task

Click Kit Issue

Filter the list if required

Enter the required quantity in the Enter job order qty field.

If the material is binned, lotted or serialised click the extended details
button to the right of the quantity field

Enter the correct extended details such as serial number etc.

Click OK

Transactions for both material and kit issues are created immediately after
reporting and can been viewed in the Transaction Review screen
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Integration

It’s possible to
configure buttons on
the workbench for non-
productive time that
relate to a works job
order. This will ensure
your non-productive
time is posted to
Enterprise Resource
Planning.
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Report non-productive time

There are various buttons on the workbench that allow an employee to report
non-productive time. Non-productive time may be applied when the employee
goes on a break, goes to lunch, goes into meetings or is performing training
related activites.

The workbench can be customised to support the different types of non-
productive time for your organisation. Refer to the advanced user guide for
further details on this subject.

By default the workbench will continue to track hours against tasks when the
user selects any of the non-productive buttons.

To report non-productive time (Break)

1. Click on Break
2. Click Return to Previous (on return)

To report non-productive time (Lunch)

1. Click on Lunch
2. Click Return to Previous (on return)
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Production Reporting
The report screen will
provide a visual
indicator to the user
when reporting
production will take
place.
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Reporting production

Production reporting is entered using the same report function as operational
quantity. Production is reported when a quantity is entered against a job order
for the last operation of activity type Run.

Production will however only post to Enterprise Resource Planning when the
option to post this is turned on in the LYNQ api Integration settings. When
entering quantity transactions for the final run operation, additional
information will be required if the finished good item is serialized, lotted or to
be receipted into a warehouse that has bins enabled.

Additional details must be entered by clicking on the Extended Details button.

Refer to report operational quantity for further information.

WO0ZA0120197.5.Run

Details: Report:
Start Date 7/20/201812:00 AM Quantity
Activity Run
Job WOZA0120197 Scray
Stock Code SFI009-ZA012
Description KoBa rowerowe, dorosli-§

¥ | Scrap Reason
Operation
Description Wheel assembly Comments
Qty (Planned) 1.00 Equipment
Qty (Today) 1.00 W
Scrap (Today) 0.00 Status
Remainin g 0.00 No change v
Hrs (Today) 55.94
Equipment
Reject Issue Report
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LYNQ End your day

Online Version The end day function is used to clock the employee out of the workbench. Any
Click here to read active tasks will be stopped immediately and the employee's status will change
this paéfe onIing. to clocked off. The employee's office time will stop being accounted for. The
The online version end day function can be run multiple times per day. By default, the end day

provides additional L . . :
links to other function is provided on entrance terminals and shop floor data collection

related information. terminals.

Equipment Off To end your day

The equivalent end day

function for equipment 1. Click on the Employee workbench.
is turn off. You should 2. Select End Day.

turn off your

equipment where

appropriate before
ending our day. Ly N Q

MICHEL
ROY
O,

Clocking Out

March 4 - 03:15

01:46ewm

Clock In >>
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LYNQ Timesheet

Online Version Timesheet entries can be used by employees to enter data rather than using
CI.iCk heito.read the real time tracking in the workbench. Timesheet entries are manually created
this page online. by the application user and can be approved, submitted or excluded from

;?jv?dne“sn:dv(;::;r;l posting no differently than transactions generated by the workbench feature.

links to other

related information. The types of transactions supported by the timesheet include:

Default Values e Labour hours
The layout and default e Quantity
values provided in
Timesheets can be
customised by

Administrators within
Advanced Settings To enter a transaction in the timesheet

e Scrap
e Status changes

Click Timesheet Entry
Click [...] in the Employee field
Select Employee
Click OK
Click [...] in the Task field
Select Task
Click OK
Click [...] in the Equipment field
Select Equipment
. Click OK
Enter a value in the Hours, Quantity, Reject or Status field
Click the + symbol
. Click Save

©ooN R Ld S

— — — —
@R =0

Once saved, the transaction will appear in the Transation Review screen and
data will shortly appear under reports and dashboards.
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LYNQ Tracking

Current Activity LYNQ provides several features to track, summarise and evaluate information
Dashboards and related to resources utilised in production. Including live dashboards with
reports are based on supporting metrics for Overall Labour Effectiveness (OLE) and Overall

actual current activity . .
and provide insight Equipment Effectiveness (OEE).

into how individual
resources (employees
and equipment) are
performing today and
your actual product e Employee Status

output (parts count). o Equipment Status
e Job Status
e Employee Performance

Core features include:

e Tracking dashboard

e Equipment Performance
e Management Reports
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Employee Availability
Known as worker
efficiency, considers
the relationship
between actual work
time related to
production jobs and
the actual attendance
(clocked) time of the
employee.

Employee Performance
Known as worker
effectiveness,
compares the actual
run rate produced by
the employee with the
planned run rate. To
determine the actual
run rate a production
guantity must be
reported.

Employee Quality
Known as the worker
quality ratio, is the
relationship between
the good quantity and
the total quantity
produced. To
determine the quality
ratio a production
guantity must be
reported. For the ratio
to be less than 100% a
scrap (bad) quantity
must be reported.

LYNQ 2019 USER GUIDE

Employee KPls

Employee Availability

Calculation Actual Work Time / Actual Attendance Time
Measure It is measured as a percentage (%). The higher the percentage
the better.

Report(s) Dashboard shows overall worker efficiency for today
Employee Status shows a worker’s efficiency for today
Employee Performance shows current and historical efficiency
for an individual worker

Employee Performance

Calculation Planned Run Time x Production Quantity / Actual Run Time

Measure It is measured as a percentage (%). The higher the percentage
the better.

Report(s) Dashboard shows overall worker performance for today for all
workers
Employee Status shows a worker’s performance for today
Employee Performance shows current and historical
performance for an individual worker

Employee Quality

Calculation Good Quantity / Total Quantity

Measure It is measured as a percentage (%). The higher the percentage
the better.

Report(s) Dashboard (Tracking) - shows overall worker quality ratio for

today for all workers

Employee Status (Tracking) - shows a worker’s quality ratio for
today

Employee Performance (Tracking) - shows current and
historical quality ratio for an individual worker
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

(OLE)

Availability,
performance and
quality as a single key
performance indicator
(KPI). The average
value of OLE in a
manufacturing
company is 40%. World
class manufacturers
operate at 75% or
above depending on
their industry (KPI).
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Overall labour effectiveness (OLE)

Overall Labour Effectiveness (OLE)

Calculation

Measure

Report(s)

Availability x Performance x Quality

It is measured as a percentage (%). The higher the percentage

the better.

Dashboard shows the overall effectiveness for today for all

workers

Employee Status shows a worker’s overall effectiveness for

today

Employee Performance shows current and historical overall

effectiveness for an individual worker
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LYNQ

Online Version
Click here to read

Equipment Availability
Known as equipment
efficiency, considers
the relationship
between actual
productive time and
the planned busy time
of the equipment. You
can set the planned
busy time for each
piece of equipment to
be based on the
schedule, the
start/stop time or

calendar time. See seat

maintenance to set
this value.

Equipment
performance

Known as equipment
effectiveness,
compares the actual
run rate produced by
the equipment with the
planned run rate. To
determine the actual
run rate a production
guantity must be
reported.

Equipment Quality
Known as the
equipment quality
ratio, is the
relationship between
the good quantity and
the total quantity
produced. To
determine the quality
ratio a production
quantity must be
reported. For the ratio
to be less than 100% a
scrap (bad) quantity
must be reported
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Equipment KPIs

Equipment Availability

Calculation Actual Productive Time / Planned Busy Time

Measure It is measured as a percentage (%). The higher the percentage
the better.

Location Dashboard shows overall equipment efficiency for today
Equipment Status shows equipment efficiency for today
Equipment Performance shows current and historical efficiency
for an individual piece of equipment

Equipment Performance

Calculation Good Quantity / Produced (Total) Quantity

Measure It is measured as a percentage (%). The higher the percentage
the better.

Location Dashboard shows overall quality ratio for today for all
equipment
Equipment Status shows the quality ratio for a specific piece of
equipment for today
Equipment Performance shows the current and historical
quality ratio for an individual piece of equipment

Equipment Quality

Calculation Good Quantity / Produced (Total) Quantity

Measure It is measured as a percentage (%). The higher the percentage
the better.

Location Dashboard shows overall quality ratio for today for all
equipment

Equipment Status shows the quality ratio for a specific piece
of equipment for today

Equipment Performance shows the current and historical
quality ratio for an individual piece of equipment
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Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

(OEE)

Represents equipment
availability,
performance and
quality as a single key
performance indicator
(KPI). The average
value of OEE in a
manufacturing
company is 60%. World
class manufacturers
operate 85% or above
depending on their
industry
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Overall equipment effectiveness
(OEE)

Overall Equipment Effectiveness (OLE)

Calculation Availability x Performance x Quality

Measure It is measured as a percentage (%). The higher the percentage
the better.

Location Dashboard shows overall equipment efficiency for today
Equipment Status shows equipment efficiency for today
Equipment Performance shows current and historical efficiency
for an individual piece of equipment
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

OLE

Views showing overall
labour effectiveness.
Availability,
performance and
quality

OEE

Views showing overall
equipment
effectiveness.
Availability,
performance and
quality

Products

Views showing
products, parts to
produce, parts count
and % complete
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Tracking dashboard

High level view of your job orders, products, employees and equipment. Select
specific employees and equipment to view status and performance for a

selected time period.

147 122 _94 147
0% wil
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To open the Dashboard:

1. Select Dashboard in Tracking
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Card View

Displays a card
summary of the
employees selected.
Clicking on employee
card takes you to
extended details of
employee status

List View

A line by line report by
employee. Click on the
employee name to view
extended details of
employee status.
Additionally, in this
view, there is a link to
view the job order
status for each job
order the employee is
involved with. Below
each column heading
there is a search/filter
box. The pin next to
the search box
provides a set of
filtering options.
Additionally, in list
view there is
functionality to export
reports, create custom
filters, customize
layouts, and apply
defined actions to
multiple records.
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Employee status

Employee status provides an at a glance live view of employees, what their
current status is, what they are working on, and how they are performing during
their shift. Drill down into each employee card for a detailed view. Use status
indicators to access their workbench to help with clocking and other
management issues.

Fmployee Status
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From this simple, single status screen you can get a lot of information. The
coloured plates show you their status.

e GREY -Out

e GREEN - Productive

e YELLOW - Direct downtime (setting up machine)

e GREEN & YELLOW - working productively on some job orders while
setting up others

e RED - Non-productive (breaks, lunch etc...)

From this screen you can also see any alerts or issues that are happening,
allowing team leads and supervisors to work to resolve the problems ASAP.
If you have the permissions you can open the workbench terminal they are
working from by clicking on the green finger icon.

To open Employee Status:

1. Select Employee Status in Tracking
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Card View

Displays a card
summary of the
equipment selected.
Clicking on equipment
card takes you to
extended details of
equipment

List View

A line by line report by
equipment. Click on
the equipment name to
view extended details
of equipment status.
Additionally, in this
view, there is a link to
view the job order
status for each job
order the equipment is
involved with. Below
each column heading
there is a search/filter
box. The pin next to
the search box
provides a set of
filtering options.
Additionally, in list
view there is
functionality to export
reports, create custom
filters, customize
layouts, and apply
defined actions to
multiple records.
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Equipment status

Equipment status provides an at a glance live view of your equipment, what the
current status is, what jobs they are running, and how they are performing
during the shift. Drill down into each equipment card for a detailed view. Use
status indicators to access the equipment workbench for management
purposes.

Equipment Status
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From this simple, single status screen you can get a lot of information. The
coloured plates show you their status.

e GREY - Off

e GREEN - Running

e YELLOW - Direct downtime (for example setup or teardown)
e RED - Indirect downtime (breakdowns and failures)

From this screen you can also see any Alerts or Issues that are happening with
the equipment. This allows team leads and supervisors to work to resolve these
problems ASAP and prevent further loss. You can also access the
equipment terminals from this screen.

To open Equipment Status:

1. Select Equipment Status in Tracking
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LYNQ Job status

Online Version Job status provides a review open job orders to check their current live status.
CI.iCk heito.read Use progress bars to gain visibility of hours booked, materials issued and
this page online. overall progress at a glance. Drill down to view specific job details including

Th li i .
prjv?dnelsn:dvctlai?(l;r;l attached documents and issues recorded.

links to other -

Order Status

related information. I = |

List view

The sub job view
provides the same
details as the list view

o
o
o
[ ]
o
o
o
(1]
o

but from here you can
expand and see the
sub job order Live indicators show:
information.

e Labour % - shows how much labour has been expended on the Job
Order

o Materials % - show what % of materials have been issued to the Job
Order so far

e Progress % - shows how the Job Order is progressing based on
Operational Quantity reporting

You can also see which Job Orders have issues.
To open Job Status:

1. Select Job Status in Tracking
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Dashboard

Graphical presentation
of employee
performance including
at a glance Hrs/Qty
stats, Key Performance
Indicators, and Loss
percentages.

Summary

Period level line by line
representation of
employee performance
with filtering functions
and export facility.

Detail

Operation level line by
line representation of
employee performance
with customization,
filtering and export
facilities.

Audit

Chronological
transaction level report
for detailed analysis
with filtering and
export facilities.

Alerts & Issues
Report of any alerts &
issues.

Attachments

View or delete
attachments.
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Employee performance

Employee Perfomance provides detailed analysis of an individual employee's
performance over time with audit trails and a record of the issues
encountered. This report displays the overall labour effectiveness
(OLE) results with support metrics for Availability, Performance and Quality.

Employee Performance

[ o | oma [ o - | JLmees

To open Employee Performance:

1. Select Employee Performance in Tracking

Page 88 /122


https://support.lynqmes.com/en-us/knowledgebase/article/KA-01654

LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Dashboard

Graphical presentation
of equipment
performance including
at a glance Hrs/Qty
stats, Key Performance
Indicators, and Loss
percentages.

Summary

Period level line by line
representation of
equipment
performance with
filtering functions and
export facility.

Detail

Operation level line by
line representation of
equipment
performance with
customization, filtering
and export facilities.

Audit

Chronological
transaction level report
for detailed analysis
with filtering and
export facilities.

Alerts & Issues
Report of any alerts &
issues.

Attachments

View or delete
attachments.
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Equipment performance

Equipment Perfomance provides detailed analysis of an individual piece of
equipments performance over time with audit trails and a record of the issues
encountered. This report displays the overall equipemnt effectiveness (OEE)
results with support metrics for Availability, Performance and Quality.

Equipment Performance DEPTA / WCLA
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To open Equipment Performance:

1. Select Equipment Performance in Tracking
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Availability

Report of availability,
with filters to display
separate values for
uptime/downtime.
Default shows total.

Adjustments

Detailed reports by
operational type
(Downtime, Uptime)
with direct access to
edit clock-in/out times.

Detail

Operation level line by
line representation of
employee’s
performance with
customization, filtering
and export facilities.

Pivot

Facility to view, create
and edit Pivot table
reports. Customize
function displays fields
available.
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Management Reports

Reports provide analytics associated with the resoures availability
(uptime/downtime) for management purposes. Includes daily clock hours
reconciliation and option to create custom management reports using pivot
tables.
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To open Management Reports:

1. Select Management Reports in Tracking
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LYNQ

Execution Control
Control which
production activities
are available to your
users with configurable
terminals
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Execution management

LYNQ provides you with an ability to define and fully customise the execution
of your production activites.

Core features include:

Terminal Maintenance

Transaction Review
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Password Protect
Terminals can be
password protected
and multiple users can
access the same
terminal from multiple
locations.
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Terminal Maintenance

Terminals are a feature in LYNQ that determine the functions that are available
to a user for data collection and reporting purposes. The terminal definition
represents a collection of predefined workbench elements which can be easily
added or removed to suit the functions of your employees. Terminals are highly
customizable and a flexible feature of the application.
There are 2 types of terminal in LYNQ:

e Clock-In terminal
e Shop Floor terminal

Clock-In terminals are typically located at the entrance of the building or
production unit to track employees clock in and clock out time. This type of
terminal may be used by all employees regardless of their functional role.
Clock-In terminals are typically limited in their functionality.

Shop Floor terminals are typically located on the shop floor and situated within
the relevant production unit. These terminals can be configured by equipment,
crew or employee to display scheduled/unscheduled shop job orders or only
shop job orders within a specific time frame or within custom filter definitions.
Additional elements can be included, (e.g. Break, Lunch, Material Issue, Kit
Issue, Production Issues) providing employees with the ability to complete all
their reporting requirements from one simple screen.

LYNQ is shipped with 8 pre-configured workbench terminal definitions ready
for immediate use. The configuration of these terminals has been designed to
service well established manufacturing models and you can start to use them
as a template with minimal further configuration.

Terminal Name Description

Clock in and out to start/end your data

Basic terminal with limited options

Advanced terminal with extended functionality
Advanced terminal with crew functionality

6 - Equipment Equipment terminal with downtime tracking
7 - Materials Advanced terminal with materials issue capabilities
8 - Office Office terminal for non-manufacturing personnel

5 - Time Entry Time entry terminal for employees using timesheets

Page 92 /122


https://support.lynqmes.com/en-us/knowledgebase/article/KA-01739

LyNQ Workbench buttons

Buttons on the workbench can apply to employees or equipment or to both
Click _to read types of resources. The buttons on the workbench are fully customisable and

this page online. additional information can be found in the advanced user guide.
The online version

provides additional

i Button Purpose Employee  Equipmen
links to other

t
related information. Start Day Clock employee in X
Start selected task(s) X
LYNQ is shipped with Stop selected task(s) X
pre-configured buttons ;
Report Report quantity, scrap, status X
for common tasks. You .
for selected job order(s)
can create your own
buttons and display Add Tasks Start unscheduled task(s) X X
them on different Recent Tasks View of recent tasks that are X
terminals. Refer to the started/stopped
advanced user guide Barcode Entry Select task(s) by scanning a X
for further information barcode
Meeting diversion X
Training diversion X
Issue Materials Issue materials for active task(s) X
Kit Issue Kit issue of materials for X
active/non- active tasks
Messages Compose, read and view X
application messages
Production Issue Create production issue
My Time Report time by manual
timesheet entry
End Day Clock Out X
Equipment Failure Report downtime due to
equipment failure
Tooling Failure Report downtime due to tooling X
failure
Unplanned Report downtime due to X
Maintenance unplanned maintenance
Material Shortage Report downtime due to X
material shortage
Operator Shortage Report downtime due to X
operator shortage
Setup/Changeover Report downtime due to X
setup/changeover
Turn Off Turn equipment off X
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Unique Terminals
Create unique
terminals for your
different work units.
This allows you to
control how you want
different terminals to
behave

LYNQ 2019 USER GUIDE

Copying terminals

Creating new terminals is easily achieved by using the copy function within
terminal maintenance. When copying terminals, the functions associated with
the terminal are also copied. Refer to the advanced user guide to better

understand how terminals can be customised in much further detail.

To copy a terminal:

O No o s e

Click Terminal Maintenance

Tick one of the pre-defined terminals

Click Copy

Enter a suitable value in the Name field for the new Terminal
Select [...] in the Linked Equipment field

Click on the work units the new terminal will relate to

Click OK

Click Save.

To test your new terminal:

o s N

Click Workbench

Click Terminals

Select your new terminal created earlier
Enter an employee ID

Click Login
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LYNQ

Click  to read
this page online.
The online version
provides additional
links to other
related information.

The LYNQ Platform
Windows Service on
the Web Server is
responsible for
consolidating your
activity into actual
transactions that can
be posted to Enterprise
Resource Planning.
The workbench will
still operate with this
service not running but
you will not see new
transactions in the
Transaction Review
screen until the service
is started.

It’s possible to
configure LYNQ so
supervisors and line
managers can only see
their own team
member’s transaction
records. Refer to the
Advanced User Guide
for further information.
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Transaction review

All actvities performed within the workbench are converted into summary
transactions so they can be reported on easily in LYNQ and posted to Enterprise
Resource Planning. Depending on your configuration, transactions may appear
immediately after peforming the activity or at differnet stages in your day. (i.e.
when you go to break, lunch or end day). Refer to the advanced user guide for
further information on this subject.

The table below provides an overview of which different transaction types are
created based on the type of activity performed.

Activity Transaction Default Integrated
Type Status to ERP
Office Time (No Task) Labour Excluded No
Quantity Quantity Unposted Yes
(Operation & Production Reporting)
Operation Reject Scrap Unposted Yes
Indirect (i.e. Break) Labour Excluded No
Indirect by Job order Labour Unposted Yes
Material Issue Material Issue Approved Yes
o o -
Production Issue Production Excluded No
Issue
o o =

By default, indirect transactions such as break, lunch etc, machine time
transactions and production issue transactions are excluded from posting to
Enterprise Resource Planning. Transaction rules determine the default status
of transactions. Depending on your configuration, you may have different
transaction rules configured to change the default approval status.

Refer to the advanced user guide for further information on this subject.
To open Transaction Review:

1. Select Transaction Review in Execution Management
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Process flow

The job order of the
tabs in the transaction
review screen help to
the approval and
posting process flow.

Different Functions
The functions change
depending upon which
tab you display.

LYNQ 2019 USER GUIDE

Transaction review functions

Let’s take a look at the layout and the different functions on the transaction
review screen to understand what it means. The screen is split into tabs.

Submitted

If LYNQ is not configured to automatically approve transactions, new

Approve an unposted transaction

Create a new transaction

Edit an unposted transaction
Copy an existing transaction
Exclude an unposted transaction

Re-approve a transaction with the status of posting error
Unpost a posted transaction or reset status to unposted
Create a new transaction

Edit a transaction with the status of pending posting
Copy an existing transaction

Exclude a transaction with the status of pending posting
Delete a transaction with the status of pending posting

Re-approve a transaction with the status of posting error

Edit a transaction with the status of posting error
Copy an existing transaction

Exclude a transaction with the status of posting error
Delete a transaction with the status of posting error
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Customise

Use the customise
function to add or
remove columns on the
screen. Each tab can
have different columns
showing.

Transaction types
Use the transaction
types filter to show
filter different
transaction types.

LYNQ 2019 USER GUIDE

Transaction review functions

>

The All tab shows all transactions regarding of their status.

Unpost a posted transaction

Create a new transaction

Edit an unposted transaction

Copy an existing transaction

Exclude a transaction

Delete an unposted/pending posting transaction

Excluded

The exclusions tab shows transactions which have been excluded from posting
to Enterprise Resource Planning. (i.e. Indirect Task Codes such as break, lunch,
training, meetings, office time)

Create a new transaction

Edit a transaction with the status of excluded
Copy an existing transaction

Delete a transaction with the status of excluded
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Grouping

Grouping your
employee data can
help to speed up the
approval process. No-
one wants to review
every single
transaction generated.
Start by grouping by
employee and then by
transaction type. Look
at the totals reported
for labour. Does the
total hours look correct
for the employee? If
so, approve them from
the grouped view. It’s
quicker and leaves you
more time to
investigate just the
exceptions.

Exclude

There may be times
where the employee
has generated a
transaction in LYNQ
but you don’t want to
post this to Enterprise
Resource Planning.
This may be where a
user has completed the
same activity in
Enterprise Resource
Planning and posting
the transaction from
LYNQ will duplicate
the transaction. In
these cases just simply
exclude the
transaction. Excluded
transactions are not
posted to Enterprise
Resource Planning.
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Approving transactions

Approving transactions is easy to do and should be done regularly to ensure
Enterprise Resource Planning maintains accurate analysis and financial data.
Throughout the approval and posting process you will see the transaction
change it’s status.

Transaction Status Meaning

Excluded Transaction has been excluding from posting to Enterprise
Resource Planning
Unposted Transaction has not been approved for posting to

Enterprise Resource Planning
Transaction has been approved and will be posted on next
sync to Enterprise Resource Planning

Pending Posting

Posted Transaction has been posted to Enterprise Resource
Planning

Posting Error Transaction cannot be posted to Enterprise Resource
Planning due to an error

Pending Unposting Transaction already posted to Enterprise Resource Planning

but will be reversed on next sync to Enterprise Resource
Planning

Unposting Transaction has not successfully been reversed from
Enterprise Resource Planning

Use the transaction screen if you wish to approve transactions on a periodic
basis regardless of the employee or job order order which can be done in other
screens. While the transaction screen shows every detail and each and every
transaction can be reviewed, you should consider whether this is (a) an
effective use of manager/supervisor time and (b) practical to do so.

Transactions that need to be approved can be reviewed from the submitted tab.

SUBMITTED APFROVED ERRORS ALL EXCLUDED

To approve transactions

Click Transaction Review

Click on the Submitted Tab

Set the Date Filter

Filter records if required that must be approved.

Select all transactions to be approved (left of the Notes column)

S

Click Approve

Once approved the transactions will no longer be seen under the submitted tab
but instead will appear under the approved tab. The status of the transaction
will change to pending posting. The next time LYNQ api executes it’s
integration schedule, the transaction will be posted to Enterprise Resource
Planning. You can however force the integration to Enterprise Resource
Planning by clicking on the sync button.
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Forget to clock out?

If you are forever
adjusting employee
hours because they
have forgotten to clock
out, you can
automatically setup a
schedule to clock out
the employee. You can
clock out individual
employees or a group
of employees. You can
also do this for break
times too or in fact any
other type of diversion.
Refer to the Advanced
User Guide for further
information.
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Adjusting transactions

There may be times where inaccurate labour time is recorded. This may be due
to the employee forgetting to stop a task or perform the end day function.
Adjusting time must be completed from the Management Reports screen for
office time and labour time.

To adjust Clock In/Out Time

Noo s e

Click Management Reports

Click on the Adjustments Tab

Select the relevant employee

Select the relevant day

Click Edit under the date from the left window pane
Set the correct Clock In and Clock Qut date/time
Click OK

To adjust the task hours

O N o e

From the same adjustment screen

Click Show Transaction List from the right window pane
Locate the inaccurate transaction(s)

Double click on the transaction

Enter the correct duration in the Labour (Hrs) field
Click Save

Select the transaction you have edited

Click Approve
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Correcting Mistakes
Dealing with a high
volume of posting
issues is not good use
of your time. You may
want to review your
processes to ensure
that users are using
the workbench
correctly. Some
validation is performed
only on posting to
Enterprise Resource
Planning and good
discipline is required.
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Reversing transactions

Transactions with a status of posted cannot be edited. To amend a posted
transaction, the transaction must be reversed using the Unpost function. When
unposting a transaction, the transaction will be reversed in Enterprise Resource
Planning and the status of the transaction in LYNQ will change from posted to
Unposted. Transactions with a status of unposted can be edited and re-
approved and posted again to Enterprise Resource Planning.

To reverse a posted transaction

Click Transaction Review

Click on the Approved Tab

Select the correct date filter to locate the posted transaction
Select the transaction to edit and click Unpost.

o s N

The status of the transaction will change to PendingUnposting

The next time LYNQ api executes the integration, the transaction will be
reversed in Enterprise Resource Planning and the status of the transaction in
LYNQ will change to Unposted. The transaction will be reversed on the original
transaction date.
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Lots of errors?
Dealing with a high
volume of posting
issues is not good use
of your time. You may
want to review your
processes to ensure
that users are using
the workbench
correctly. Some
validation is performed
only on posting to
Enterprise Resource
Planning and good
discipline is required.
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Transaction errors

There may be occasions where a transaction generated by LYNQ fails to post
to Enterprise Resource Planning. Transactions that cannot post due to an error
should be corrected and re-approved for posting. Transactions that cannot
post to Enterprise Resource Planning can be viewed from the Errors tab in the
Tranaction Screen. The transaction will have a status of posting error.

Double click on the transaction to view the details

PLANNING | | FACTORY

Edit Transaction

CLOSE

General

Trx Date 71412019 = Excluded Submitted Approved
Employee 2

o B - 00O

Scrap 1.000000 - -
Comments Click to add

mments Error Scrap. Scrap code 'Scrap’ not found;
Additiona

In the example above the transaction cannot post due to an incorrect scrap
reason code. To correct the transaction, the scrap reason code can be edited
by clicking on [...] to the right of the scrap field and then the transaction can be
set to Retry. Selecting retry from the transaction edit screen will change the
status of the transaction to Pending Posting. The next time LYNQ api executes
the integration, the transaction will be posted.

Scrap for WEB-347-D.1.Run

ScrapEntry [| =

Quantity Scrap Reason Comments

Clear L scrap - scraclill e
Scrap - Scrap
DC - Dust contamination
Total: 1 DG - Damaged goods
ES - Early supply
LS - Late supply
RM - Raw material quality problem

Transactions that cannot be posted from LYNQ can be set to Accepted. This
means that any corrections will need to be made manually in Enterprise
Resource Planning.

In previous versions of LYNQ the labour value was the only field that could be
edited in the Transaction Review Screen. This made the correction of data
errors long winded to resolve with the user having to copy, delete and then edit
the copied transaction.
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LyNQ Transaction errors

Online Version Now when editing Transactions, it’s possible to edit:
Click here to read

this page online. 1. Transaction Date
The online version
© 9 © e. S ° 1. Employee Code
provides additional )
links to other 2. Membership Code
related information. 3. Task Code
4. Labour Hrs
Lots of errors? e L
Dealing with a high b. Classification Value
volume of posting
issues is not good use HOME ' | FACTORY
of your time. You may Edit Transaction
want to review your
processes to ensure General s — N
. Trx Date 7/3/2019 - et ubmit=c Approve
that users are using — - @ @ @
the WorkbenCh Membership CREW C
correctly. Some Tesk
validation is performed Equipment BRILL/ DRILOL
Only On postlng to Labor (Hrs} 5.83224765454
Enterpnse Resource Classification Value Classification Code 3
. Comments Click to add
Planning and good .

discipline is required.

For a full list of errors please logon to the support portal and search based on
your error code www.support.lyngmes.com
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LYNQ

Dashboard

Graphical presentation
of employee
performance including
at a glance Hrs/Qty
stats, Key Performance
Indicators, and Loss
percentages.

Summary

Period level line by line
representation of
employee performance
with filtering functions
and export facility.

Detail

Operation level line by
line representation of
employee performance
with customization,
filtering and export
facilities.

Audit

Chronological
transaction level report
for detailed analysis
with filtering and
export facilities.

Adjustments
Detailed reports by
operational type
(Downtime, Uptime)
with direct access to

edit clock-in/out times.

Alerts & Issues
Report of any alerts &
issues.
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Continuous Improvement

LYNQ supports Six Sigma methodologies such as DMAIC (Define, Measure,
Analyse, Improve, and Control) by providing the definition of what to measure,
the measurement itself and the analysis so that loss can be targeted, reduced
and/or eliminated.

This helps to drive continuous improvement within your environment, bringing
manufacturing processes under control with greater efficiency and productivity
as a result.

Core features of Continous Improvement:

e Loss Management
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Six Big Loss

LYNQ supports
continuous
improvement by
providing Six Big Loss,
Loading and other
analysis. It not only
provides the key
performance indicators
(KPI's), but also
provides the metrics
and the means of
measurement, out of
the box
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Loss management

LYNQ supports Six Sigma methodologies such as DMAIC (Define, Measure,
Analyse, Improve, and Control) by providing the definition of what to measure,
the measurement itself and the analysis so that loss can be targeted, reduced
and/or eliminated. This helps to drive continuous improvement within your
environment, bringing manufacturing processes under control with greater

efficiency and productivity as a result.

The Loss Management report has been enhanced to include four financial loss

visualisations:

e %
e Hour
e Rate

e Revenue

A default system wide labour rate, employee revenue rate, overhead rate,
equipment revenue rate can be setup in Advanced Settings/General. Rates can
also be setup at the seat level in seat maintenance which will override the

system wide settings.

Financial settings in Advanced Settings:

|Advanced Settings

Rate settings in Equipment Maintenance

Equipment Maintenance

R cLosE

Source

Equipment group

ERP LYNQ

Manual Auto

Overhead rate

Revenue rate

Capacity

Capacity UOM

Equipment

Display name

Number of resources

Planned availability calculated by

1.00

Clocked Time
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LyNQ Loss management

The Loss Management Dashboard displays realisation of loss across your
Click _to read manufacturing operations with every loss identified, classified (Six Big Loss)

this paéfe onIing. and quantified to allow for counter measures to be applied and continuous
The online version

provides additional
links to other

improvement to be made.

related information. ‘ ‘ ‘ ‘
-18375% -9221% 0% -1804% 0%
LYNQ supports
continuous *
improvement by e
providing Six Big Loss,
Loading and other
analysis. It not only s
provides the key
performance indicators
(KPI’s), but also Different Visualisations of Loss Management
provides the metrics
and the means of Visualisatio Type Meaning
measurement, out of n
the box Loss Management by % Shows the loss in percentage
of hours for your
manufacturing operation
Loss Management by Shows the loss in hours for
Hour your manufacturing operation
Loss Management by Shows the loss at cost value
Rate for your manufacturing
operation
Loss Management by Shows the loss at revenue
Revenue value for your manufacturing
operation
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LYNQ Performance analysis

Historical Activity LYNQ provides numerous Live factory dashboards including supporting metrics
Dashboards and for Total Effective Equipment Performance (TEEP)
reports are based on

actual historical Core features include

activity and provide

insight into how Dashboard

multiple resources )

(employees and Loading

equipment) have Availability

performed over time, Performance

what was produced Quality

and details of any
production variances
(planned vs actual)
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Employee Analysis
Equipment Analysis
Product Analysis
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Online Version Factory Utilisation
Click here_to read
this page online. Calculation Scheduled Hours / Calendar Hours

Factory Utilisation
Known as plant loading

or utilisation, considers
the proportion of Report(s) Loading shows the planned plant utilisation with
comparisons to last month and last quarter. It also provides
insight as to why plant utilisation is not 100%.

Measure It is measured as a percentage (%). The higher the
percentage the better.

calendar time that has
been scheduled for
production (run time).

Factory Availability Factory Availability

Known as plant

efficiency, considers Calculation Actual Productive Time / Planned Busy Time

the relationship

between actual Measure It is measured as a percentage (%). The higher the

productive time and
the planned busy time
of the equipment.
Factory availability
shows the aggregated
availability based on
your resources.

percentage the better.

Report(s) Availability shows the plant availability with comparisons
to last month and last quarter. It also provides insight as
to why plant availability was not 100%.

Factory Performance

Factory Performance
Known as plant

effectiveness,
compares the actual Measure It is measured as a percentage (%). The higher the

percentage the better.

Calculation Planned Run Time x Production Quantity / Actual Run Time

run rate produced by
the plant with the Report(s) Performance shows the plant effectiveness with

planned run rate. comparisons to last month and last quarter. It also provides
Factory performance insight as to why plant performance was not 100%.

shows the aggregated

availability based on

your resources Factory Quality
(employee or
equipment). Calculation Good Quantity / Total Quantity

Factory Quality
Known as the plant
quality ratio, is the
relationship between Report(s) Quality shows the plant output quality with comparisons to
last month and last quarter. It also provides insight as to why
plant output quality was not 100%.

Measure It is measured as a percentage (%). The higher the
percentage the better.

the good quantity and
the total quantity
produced. Factory
performance shows the
aggregated output
quality based on your
resources (employee or
equipment). To
determine the quality
ratio a production
quantity must be
reported.
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Product Throughput
Considers process
performance in terms
of the produced
quantity and the actual
uptime. Product
throughput can be
reviewed based on
employee or equipment
throughput.

Product Quality
Considers the
relationship between
the good quantity and
the produced quantity.
Product quality can be
reviewed based on
employee or equipment
throughput to provide
visibility of patterns
and greater
understanding of
where counter-
measures need to be
applied for increase
product output.
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Product KPlIs

Product Throughput Rate

Calculation Parts Count (based on actual uptime) / Ideal Count (based
on planned uptime)

Measure It is measured as a percentage (%). The higher the
percentage the better.

Report(s) Loading shows the planned plant utilisation with
comparisons to last month and last quarter. It also provides
insight as to why plant utilisation is not 100%.

Product Quality Ratio

Calculation Good Quantity / Produced (Total) Quantity

Measure It is measured as a percentage (%). The higher the
percentage the better.

Report(s) Product Analysis - shows product quality ratio by production
process (operation)
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LYNQ

Online Version
Click here_to read
this page online.
The online version
provides additional
links to other
related information.

Total Effective
Equipment
Performance

(TEEP), shows how well
a manufacturing unit or
plant is performing
relative to calendar
hours.
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Total effective equipment
performance (TEEP)

Total Effective Equipment Performance
Calculation Loading x Availability x Performance x Quality

Measure It is measured as a percentage (%). The higher the
percentage the better.

Report(s) Dashboard shows the current & historical total effective
equipment performance for a specific manufacturing unit or
for the entire plant
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

TEEP

Showing both OEE and
TEEP key performance
indicators.

Available Hours

The total number of
actual productive
hours for the selected
resources and time
period.

Performance Hours
The calculated hours
based on the total
quantity produced
(good and bad).

Effective Hours
The calculated hours

based on only the good

quantity produced.

Lost Hours
The total number of

hours lost in producing

only good product
when compared with
scheduled {(planned)
hours.
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Factory dashboard

Performance Analysis Dashboard provides factory level analytics of equipment
showing both overall equipment effectiveness (OEE) and total effective
equipment productivity (TEEP) key performance indicators. Drilldown to
supporting metrics and measurement of Loading, Availability, Performance and
Quality.

‘M%‘

Py

7.00 1176 535 454 402 345 190

7N 7 77

46% "‘} X m%, Mu‘r} 86% f :r}

~ot ~L ~LS

-42% -15% -11% -14%

o
®
)

To open Performance Analysis Dashboard:

1. Select Dashboard in Performance Analysis
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Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Operating Hours

The total number of
shift hours for the
selected resources
within the time period.

Scheduled Hours

The total number of
planned productive
hours for the selected
resources within the
time period.

No Shift Hours

The total hours lost as
a result of having no
shift within the
selected time period.

No Shift Loss

The total hours lost as
a result of having no
shift within the
selected time period
(shown as a
percentage).

Planned Downtime

The total planned
downtime hours within
the selected time
period. Operating
hours - scheduled
hours where scheduled
hours are productive
(uptime) hours.

Downtime

The ratio shown as a
percentage of the
planned downtime
compared with
planned operating
time.
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Loading

The Loading Report provides detailed analysis of the loading position
of resources with comparisons to last month and/or quarter to understand
trends. Use this to compare your planned uptime with all the time available
(calendar time) to gain insight of asset utilisation to support capital expenditure
and other management decisions.
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To open Loading:

1. Select Loading in Performance Analysis
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LYNQ

Online Version
Click here to read
this page online.

Scheduled Hours

The total number of
planned productive
hours for the selected
resources and time
period.

Available Hours

The total number of
actual productive
hours for the selected
resources and time
period.

Availability

The percentage of
actual uptime
compared with
planned uptime for the
selected resources and
time period.

Breakdown Hours
Unplanned hours lost
as a result of
breakdown.

Adjustment Hours
Unplanned hours lost
as a result of setup and
adjustments.

Unplanned Down

The total hours lost as
a result of unplanned
issues relating to the
selected resources and
time period.

Downtime

The ratio shown as a
percentage of the
unplanned downtime
compared with
schedule (planned)
hours for the selected
resources and time
period.
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Availability

The Availability Report provides detailed analysis of the availability
of employees or equipment with comparisons to last month and/or quarter to
understand trends. Use this to gain insight of your actual uptime compared with
your planned uptime and see where unplanned downtime occurs in relation to
equipment breakdowns, tooling failures, operator shortages and more.

Availability - By Equipment — — B St o] st | (st 5] (v s smusoss oy = | e || e Tt

11.00 909 692 76% 61 0 61 24%

=
0% 5 o%\ .J‘

To open Availability:

1. Select Availability in Performance Analysis
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LYNQ

Online Version
Click here to read
this page online.

Performance Hours
The calculated hours
based on the total
quantity produced
(good and bad) for the
selected resources
within the time period.

Effective Hours

The calculated hours
based on the good
quantity produced for
the selected resources
within the time period.

Quality

The ratio shown as a
percentage of the
effective hours
compared with the
performance hours.

Total Units

The total number of
units actually
produced (good and
bad) by the selected
resources within the
time period.

Units Scrapped

The total number of
bad products produced
by the selected
resources within the
time period.

Loss hours

The difference
between calculated
performance and
calculated effective
hours.

Quality Loss

The ratio shown as a
percentage of hours
lost in the production
of bad product.
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Quality

The Quality Report provides detailed analysis of the quality output from
employees or equipment with comparisons to last month and/or quarter to
understand trends. Use this to gain insight by resource of where product quality
issues have affected your output.

Quality - By Equipment By Equement = scledt Gaamnt.

11.00 613 525 86%
ﬂa%i :‘n 86% ‘:«}
~ ./' LA

To open Quality:

1. Select Quality in Performance Analysis
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LYNQ Employee analysis

Online Version The Employee Analysis report provides detailed analysis of employee
Click here to read performance. Filter by individual employees or analyse performance for a

this Paéfe onIing. specific group of employees. Further analyse by date or diversion
The online version

prOVideS additional Employee Analysis ‘Selnct bmplarme. Week |- Wemliaams Lzwmols x| P | el || Aemen
links to other L B EC e B
related information.

e e 89 94 36 71
Dashboard 16 == \-)

Graphical presentation

of employee s . I
performance including

at a glance Hrs/Qty . — : e ~
stats, Key Performance
Indicators, and Loss
percentages.

By Employee To open Employee Analysis:

Line by Line report by
employee with facility
to customise, create
advanced filters and
export.

1. Select Employee Analysis in Performance Analysis

By Period

Line by Line report by
period with facility to
create advanced filters
and export.

By Diversion

Line by Line report by
employee with
Diversion information
(Production/Setup etc)
with facility to
customise, create
advanced filters and
export.

Availability

Line by Line report by
employee with
Availability information
(Uptime/Downtime)
with facility to
customise, create
advanced filters and
export.
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LYNQ

Online Version
Click here_ to read
this page online.
The online version
provides additional
links to other
related information.

Dashboard

Graphical presentation
of equipment
performance including
at a glance Hrs/Qty
stats, Key Performance
Indicators, and Loss
percentages.

By Equipment

Line by Line report by
equipment with facility
to customise, create
advanced filters and
export. Links to
Equipment
Performance report.

By Period

Line by Line report by
period with facility to
create advanced filters
and export.

By Diversion

Line by Line report by
equipment with
Diversion information
(Production/Setup etc)
with facility to
customise, create
advanced filters and
export.

Availability

Line by Line report by
equipment with
Availability information
(Uptime/Downtime)
with facility to
customise, create
advanced filters and
export.
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Equipment analysis

The Equipment Analysis report provides detailed analysis of equipment
performance. Filter by individual equipment or analyse performance for a
specific group of equipment. Further analyse by date or diversion.

Equipment Analysis elec st e %] [ W oa 1jmeto amarmate o] B || West [

[ | R e |
RESOURCES (11 -
11 76 89 86 58 ,
-]

To open Equipment Analysis:

1. Select Equipment Analysis in Performance Analysis
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LyNQ Product analysis

Online Version The Product Analysis report provides output and quality analysis for products
Click here_to read by employee and/or equipment.

this page online.

The Onllne Verslon Product Analysis i | [ e cmmn | P | ter ]| s

provides additional
links to other
related information.

Performance

Combined graphical
presentation and detailed
report (by stock code), with

link to individual stock code
performance details.
To open Product Analysis:
Quality
Combined graphical 1. Select Product Analysis in Performance Analysis
presentation and detailed
report (by stock code), with
link to individual stock code
quality details.
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LYNQ

Customisable
Customise your alerts
and issues to provide
better management
and control of your
manufacturing
environment.

LYNQ 2019 USER GUIDE

Alerts & Issues

LYNQ provides alerts and issues which can be triggered by the data being

collected helps to ensure control.

Core features include

Alert Maintenance
Issue Maintenance
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Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Activate Alerts

By default alerts are
turned off. You can
enable alerts easily
from the alert
maintenance screen.
You must specify the
alert thresholds, which
resources are
measured, and which
resources will receive
the defined alert.

LYNQ 2019 USER GUIDE

Alerts which can be configured to monitor performance, quality, or vailability
for either employees or equipment. Users that are assigned as a group owners
will automatically receive Management Alerts for group members (employees
or quipment) as defined in groups.

A management alert can be configured in such a way that an alert will be

alert as a warning and an issue as a problem that requires root cause analysis.
The problem (issue) needs investigating and to avoid any repeat issues arising,
corrective action taken.

Alerts can be configured to:

e Generate a message (Visible in the message center and dashboards
and reports)

e Generate an email (sent externally via SMTP)

e Generate a production issue (visible in the issue log and other
dashboards and reports)
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Alert Name Threshold
Employee Availability 75-120
Employee Downtime 0-15
Employee Group Availability Hours 75-120
Employee Group Performance 75-120
Employee Group Quality 75-120
Employee Non Conformance 75-120
Employee Performance 75-120
Employee Quality 75-120
Employee Availability 75-120
Equipment Availability 75-120
Equipment Downtime 0-15
Equipment Group Availability 75-120
Equipment Group Performance 75-120
Equipment Group Quality 75-120
Equipment Non Conformance 0-15
Equipment Performance 75-120
Equipment Quality 75-120
Time Since Clock In 0-0.07
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Messaging Shop Floor
Shop floor users don’t
usually have their own
domain accounts or
email accounts but
with the message
center you can share
information with these
users easily.

LYNQ 2019 USER GUIDE

Message center

The message center allows you to send and receive messages to and from the
shop floor. Review performance and other data alerts. The messages you see
in the message center are only related to your own user seat.

HOME | PLANNING | | FACTORY PRINT | EMAIL | BOOKMAR

Message Center [Fenez_[*][7rzsi202e || [Froizone

‘ oNE ” e |‘ = ‘
e P — srere

Type From Subject Sent

€ Message Sarah Kingswell Christmas Shutdown 2019 Period 10:10 PM

€I Message Sarah Kingswell Progress Meeting tomorrow at 10AM 10:09 PM

To read and send messages

From LYNQ home page click on message center
Click New to create new message

In the To field select the recipient

Enter a subject

Enter your message in the body section

Click Send

oo s wN s

Messages can be sent by employees from the workbench where the message
button has been added to the terminal design. Messages from the shop floor
are sent dependant upon the group security and message settings in Home,
Advanced Settings, General

Employees working in the workbench do not have the ability to select who the
message is sent to. The recipient of the message is determined by the owners
of the group(s) that the employee is a member of. Groups are associated to the
employee in seat maintenance and Group Owners are associated to Users.
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LYNQ

Online Version
Click here to read
this page online.
The online version
provides additional
links to other
related information.

Custom Issues

Refer to the Advanced
User Guide to setup
Custom Issues for
reporting and
analytical purposes.
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Issue maintenance

LYNQ provides your organization with a number of pre-defined production issue
codes for reporting and analytical purposes. Additional production issue
codes can be created to meet the reporting and analytical requirements of the

organization.
Default issues include:

Type Category

Availability Breakdown
Setup and Adjustments

Minor Stops

Performance

Reduced Speed
Under Design Capacity

_ Rejects

Custom Health & Safety

Loading

Production issues are created either:

e Manually from the Issue Log option

Classification
Breakdowns

Setup and Adjustments
Cleaning/Checking
Component Jams
Delivery Blocked
Equipment Wear
Obstructed Product Flow
Sensor Blocked
Operator Inefficiency
Rough Running

Under Design Capacity
Production Rejects
Start-up Rejects
Accident

Near Miss

Loading Issue

e By using the Track Performance Abnormality Setting which is

configured in the Workbench Onscreen Element. When turned on,

LYNQ will prompt the user to enter a reason why performance is

abnormal

e Via an alert which is configured to trigger an issue
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LYNQ Issue log

Online Version When new Production Issues are raised by Manufacturing Employees, issues
Click here to read can be assigned to any user that has been created as a full application User.
this page online. Typically, issues would be assigned to the Manufacturing Employees
The online version Supervisor or Line Manager. Once an issue has been created, the Production

provides additional ) L .
links to other Issues lcon for the assigned application user will change to orange. The

related information. assigned application user can either resolve the issue or assign the issue to
another user.

Issues from Alerts

Check out the To assign an issue to a user

Advanced User Guide

to learn how alerts can

be used to configure

powerful alerts across

your factory.

From LYNQ home page click on Issue Log
Select the issue

Click Assign

Select the user the issue will be assigned to

AN

To resolve an issue

From LYNQ home page click on Issue Log
Select the issue
Click Resolve

Eal S

The issue will now appear as resolved
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Your business.
Understood.
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